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 SAFETY INFORMATION 
For your safety and protection, read this entire user manual before  you attempt to use the Broadband Global 
Area Network (BGAN) Satellite Terminal. In particular, read this safety section carefully. Keep this safety 
information where you can refer to it if necessary. 

WARNING SYMBOLS USED IN THIS MANUAL 

 

WARNING 
Potential radio Frequency (RF) hazard. Where you see this alert symbol and WARNING 
heading, strictly follow the warning instructions to avoid injury to eyes or other personal 
injury. 

 

WARNING 
Where you see this alert symbol and WARNING heading, strictly follow the warning 
instructions to avoid personal injury. 

 

DANGER 
Electric shock hazard: Where you see this alert symbol and DANGER heading, strictly follow 
the warning instructions to avoid electric shock injury or death. 

 

WARNINGS FOR SATELLITE TERMINAL 

 

DO NOT STAND IN FRONT OF THE ANTENNA 
This device emits radio frequency energy. To avoid injury, do not place head or other body 
parts in front of the satellite antenna when system is operational. Maintain a distance of two 
meters or more from the front of the Satellite Terminal antenna. 

 

PROPERLY GROUND THE EXTERNAL ANTENNA 
Failure to properly ground the optional external antenna may result in severe personal injury 
or death. Do not attempt to ground the optional external antenna unless you have the skills 
to do so in accordance with local electrical codes. 

 

DO NOT OPERATE DURING ELECTRICAL STORMS 
Operation of the Satellite Terminal during electrical storms may result in severe personal 
injury or death. Disconnect the Terminal from the computer and store the unit indoors if 
lightning is anticipated in the area of operation. 
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GENERAL 
Handle your Satellite Terminal with care. The enclosure is weather resistant per IEC 60529 
IP55; however, do not submerge the unit or expose it to severe rain storms. Avoid exposing 
your Satellite Terminal to extreme hot or cold temperatures outside the range -25ºC to 
+60ºC. 

Avoid placing the Terminal close to cigarettes, open flames or any source of heat. 

Changes or modifications to the Terminal not expressly approved by Hughes Network 
Systems could void your authority to operate this equipment. 

Only use a soft damp cloth to clean the Terminal. 

To avoid impaired Terminal performance, please ensure the unit’s antenna is not damaged or 
covered with foreign material like paint or labeling. 

When inserting the USIM/SIM, do not bend the it or damage the contacts in any way. When 
connecting the interface cables, do not use excessive force. 

 

IN THE VICINITY OF BLASTING WORK AND IN EXPLOSIVE ENVIRONMENTS 
Never use the Satellite Terminal where blasting work is in progress. Observe all restrictions 
and follow any regulations or rules. Areas with a potentially explosive environment are often, 
but not always, clearly marked. Do not use the Terminal while at a petrol filling station. Do 
not use near fuel or chemicals. 

 

QUALIFIED SERVICE 
Do not attempt to disassemble your Satellite Terminal. The unit does not contain consumer-
serviceable components. Only qualified service personnel may install or repair equipment. 

 

BATTERIES AND ACCESSORIES 
Use approved batteries (HNS P/N 3003702-0001) and accessories only. Use of non-approved 
accessories may result in loss of performance, damage to the Satellite Terminal, fire, electric 
shock or injury.  

AC Mains power adapter (HNS P/N 3003727-0001) is for indoor use only. It has an indoor 
operating temperature range of 0ºC to +40ºC and provides an output voltage of 20 VDC.  

The storage capacity of the battery decreases when operated. 

The terminal will only charge the battery when the temperature is within the range of 0 to 45 
degrees C. 

 

CONNECTING DEVICES 
Never connect incompatible devices to the Satellite Terminal. When connecting the Satellite 
Terminal to any other device, read the device’s User Manual for detailed safety instructions. 
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PACEMAKERS 
The various brands and models of cardiac pacemakers available exhibit a wide range of 
immunity levels to radio signals. Therefore, people who wear a cardiac pacemaker and who 
want to use a Satellite Terminal should seek the advice of their cardiologist. If, as a pacemaker 
user, you are still concerned about interaction with the Satellite Terminal, we suggest you 
follow these guidelines: 

 Maintain a distance of 30 cm between the Terminal and your pacemaker; 

 Maintain a distance of two meters from the front of the unit’s antenna; 

 Refer to your pacemaker product literature for information on your particular device. 

If you have any reason to suspect that interference is taking place, turn off your Satellite 
Terminal immediately! 

 

HEARING AIDS 
Most new models of hearing aids are immune to radio frequency interference from Satellite 
Terminals that are more than 2 meters away. Many types of older hearing aids may be 
susceptible to interference, making it very difficult to use them near a Terminal. Should 
interference be experienced, maintain additional separation between you and the Satellite 
Terminal. 
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INTRODUCTION 
 

ABOUT THIS PRODUCT 
The Hughes Network System (HNS) 9201 Broadband Satellite Terminal and WLAN Access Point is your gateway 
to global communication. The 9201 allows you to simultaneously send and receive IP packet and circuit-switched 
data via Universal Serial Bus (USB), Ethernet, Integrated Services Digital Network (ISDN), and WLAN interfaces 
over the Inmarsat BGAN satellite network.  

The unit offers you the following features and benefits: 

 492 kbps data (transmit and receive) 

 Speech (4Kbps) 

 ISDN voice (3.1KHz audio) 

 ISDN data (64kbps) 

 WLAN access point 

 Multi-user capability for sharing a single unit 

 Selectable Quality-of-Service (QoS) 

 Full IP compatibility for Email, file transfer (FTP), browsing, VPN, etc. 

 Cost-effective “always-on” access – charges only for data sent and received 

 UMTS IP-based services 

 WLAN, FCC, CE, and GMPCS certified 

 Subscriber Identification Module (SIM) card security 

 LED indicators and audio pointing aids for obtaining an Inmarsat satellite signal 

 GPS and WLAN status LEDs 
 

The unit is easy to install and connects in minutes. It is built for use in fixed, semi-fixed, and portable environments. 
The rugged design allows the unit to be installed outside in extreme weather conditions for extended periods of 
time, and the small size and weight lets you easily move it from site to site. 

The Satellite Terminal carries a warranty for 12 months from the date of sale. Contact you Service Provider if you 
have questions about the warranty, or need to return the terminal for repair. 

In this document, the following names and abbreviations are used to identify the Satellite Terminal, your computer, 
and the linked Satellite Terminal and computer: 

Term Definition 

Terminal Satellite Terminal 

TE Terminal Equipment (your computer) 

UT User Terminal  
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ABOUT THIS USER GUIDE 
This user guide contains the most up-to-date information available on this product as of the date it was generated. 
It also provides a printed version of the QuickStart Wizard which is available on the installation CD. Some of this 
information is also found in appropriate, albeit, more detailed sections of this user guide. 

 

COVERAGE AREA 

 
The coverage map shows the globally-available satellite coverage. You are able to access multiple satellites around 
the world. The BGAN Radio Access Network (RAN) includes the BGAN Radio Network Controller (RNC) and 
BGAN RF Subsystem. It handles all radio-related aspects of the BGAN ground system network infrastructure. The 
RF subsystem provides communication to and from the User Equipment community via the Inmarsat 4 satellite 
constellation. The RNC interfaces to the Core Network (CN) for switching and routing calls and data connections 
to and from the external networks. 
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PACKAGE CONTENTS 

 
When you unpack the Satellite Terminal package, you will find these standard components: 

 BGAN 9201 Broadband Satellite Terminal and WLAN Access Point 

 Rechargeable lithium ion battery pack 

 AC Mains Power Adapter and cable (100 – 240 VAC) 

 USB cable 

 Ethernet cable 

 ISDN cable 

 Installation CD 

These are optional accessories you may choose to include in the package: 

 Extra standard lithium ion battery pack 

 Extended lithium ion battery pack 

 Standard AC Mains power adapter (100 – 240 VAC) 

 Fixed installation kit 

 Vehicular Power Adapter 

Your Service Provider will supply a Subscriber Identification Module (SIM) and Satellite Terminal configuration 
instructions – you will need these to access the network. 
 

MINIMUM SYSTEM REQUIREMENTS 
These are the minimum computer system requirements for successful interface with the Satellite Terminal: 

 CD-ROM (for installation CD) 

 Internet Browser:  Microsoft Internet Explorer version 5.5 or later; Netscape Communicator version 7.0 or 
later (Java must be active). 

 PC Support for at least one of these interfaces – USB, Ethernet, ISDN or WLAN. 

 Intel Pentium III CPU, or equivalent. 

 100 MB of free hard disk space. 

 128 MB of RAM. 
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 QUICKSTART GUIDE 
 

INTRODUCING BGAN QUICK START GUIDE 
This Quick Start Guide is the simplest and quickest way to connect to the BGAN service. If you are a first time 
user, you will be guided through the procedure for powering up your terminal, obtaining a GPS fix, connecting 
your computer to the terminal and registering with the BGAN network. You are then ready to start using voice 
and broadband services. 

If you have connected to the BGAN network before, the Quick Start Guide will guide you through the steps for 
obtaining a GPS fix, changing the interface between your computer and your terminal, and registering with the 
BGAN network. 

As a first step, review one of the following topics: 

 If this is the first time you have connected to BGAN, see Setting Up Your Terminal in this section. 

 If you have connected to BGAN before, see Obtaining a GPS Fix in this section. 
 

SETTING UP YOUR TERMINAL 
To set up your terminal, you must: 

 Install the USIM/SIM Card and the Battery. 

 Put the Battery on Charge. 

INSTALLING THE USIM/SIM CARD AND THE BATTERY 

To perform this step you need the following: 

 USIM/SIM Card – supplied by your Service Provider  

 Rechargeable Battery – supplied with your terminal  
 

To set up the terminal: 

1. Position the terminal so that the battery door is facing you.  

2. Open the battery door. (If you have already installed the battery, release and then remove it.) 
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3. Push the button on the left-hand side of the USIM/SIM card holder. This releases the holder from its slot. 

 

4. Install the USIM/SIM card in the card holder making sure it is snapped into place. 

 

5. With the card in place, orient the holder with the card’s gold contacts facing down. Place the holder back in 
its slot in the BGAN terminal. 
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6. Put the battery into its slot in the BGAN terminal and lock it in place. Close and lock the battery door. 

 

PUT THE BATTERY ON CHARGE 

To charge the battery, connect the AC/DC adapter to the terminal and an external power source (see Using the 
AC/DC Adapter). The temperature of the battery must be within 0 to 45 degrees for charging to take place 
successfully. 

Note: You can use the terminal while the battery is charging. 

USING THE AC/DC ADAPTER 

The AC Mains power adapter is for indoor use only. It has an indoor operating temperature range of -10ºC to 
+55ºC and provides an output voltage of 20 VDC. 

To power the terminal using the power adapter: 

1. Remove the power adapter from the terminal box.  

2. Insert the power adapter output connector to the DC Power Input Jack on the back of the terminal, as shown 
below: 
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3. Insert the plug end into any AC outlet between 100 and 240 VAC.  

You are now ready to install BGAN LaunchPad. 
 

INSTALLING BGAN LAUNCH PAD 
As a first step, Inmarsat recommends that you install BGAN LaunchPad on your computer. If USB is used then it is 
a requirement to install BGAN LaunchPad and the terminal's USB driver first. You can use BGAN LaunchPad to 
open and manage data connections, manage and monitor terminal operations and monitor the status of the 
connections between your terminal and your computer. 

To install BGAN LaunchPad on your computer: 

1. Insert the Inmarsat BGAN LaunchPad Installation CD into your computer's CD-ROM drive.  

2. Follow the on-screen instructions.  

BGAN CORPORATE EDITION OR PERSONAL EDITION 

You have the option of installing the BGAN LaunchPad Personal Edition or the BGAN LaunchPad Corporate 
Edition. 

BGAN LaunchPad Personal Edition is for personal use, and has the following properties: 

 All BGAN LaunchPad features are available to you.  

 You can personalize all of BGAN LaunchPad's functions and features without restriction.  
 

BGAN LaunchPad Corporate Edition is for corporate users and has the following properties: 

 A user profile is required with the corporate edition. A user profile is created with a separate application 
called BGAN LaunchPad Corporate Profile Maker.  

 The user profile defines user restrictions so some features may not be available to you, depending on the 
configuration that has been set up by your Corporate IT Manager or service provider.  

 You are asked to enter a username and password when logging in to BGAN LaunchPad.  

You are now ready to obtain a GPS fix. 
 

OBTAINING A GPS FIX 
The BGAN network requires a valid GPS fix to successfully register your BGAN terminal. To obtain a GPS fix, 
take the BGAN terminal outside and lay it down flat. Verify that the unit has an open view of the sky. The GPS 
LED starts to flash green indicating that the terminal is acquiring a GPS fix. 

 

Now leave the terminal to acquire a GPS fix. This may take a few minutes. Once the GPS fix has been acquired the 
GPS LED will turn solid green. 

 

Note: If the GPS indicator light is solid red, the GPS receiver is faulty. Contact your Service Provider. 

You are now ready to Connect the Terminal to the Computer. 
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CONNECTING THE TERMINAL TO THE COMPUTER 
Connect your computer to the BGAN terminal using one or more of the following methods: 

 USB – use the USB cable supplied with your BGAN terminal.  

 Ethernet – use the Ethernet cable supplied with your BGAN terminal.  

Note: The terminal can be configured using the USB, Ethernet or WLAN interfaces. However, during the initial 
setup, the terminal configuration can only be done using either a USB or an Ethernet connection. Once the 
terminal has been configured, all four interfaces (USB, Ethernet, WLAN and ISDN) can be used for data transfer 
depending on the service required. 

Your computer must be configured to support your chosen connection method. Refer to the documentation 
supplied with your computer for details. 

CONNECTING BY USB 

To connect the BGAN terminal to the computer using the USB port: 

1. Connect the supplied USB cable to your computer’s USB serial port, and insert the other end of the 
connector into the BGAN terminal’s USB port. 

 

Note: When you install LaunchPad the USB driver for the terminal will also be installed. When you plug in the 
USB cable for the first time, Windows will use this driver to connect to the terminal.  

2. At the terminal connection point, slide the cable through the rubber door slot in order to secure and protect 
the connection. 

3. When you connect the USB cable to your computer for the first time, your computer will detect that new 
USB Hardware has been connected. It will then prompt you to install the corresponding USB driver software. 
The USB driver software will have been loaded onto your computer when the LaunchPad was installed. You 
should then follow the computer’s instruction to install the Hughes USB LAN LINK driver software (for 
computers using the Windows operating system, the installation is carried out using a Found New 
Hardware Wizard).  
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CONNECTING BY ETHERNET 
To connect the BGAN terminal to the computer using Ethernet: 

1. Connect the supplied Ethernet cable to your computer’s Ethernet port, and insert the other end of the 
connector into the BGAN terminal’s Ethernet port. 

 

2. At the terminal connection point, slide the cable through the rubber door slot in order to secure and protect 
the connection. 
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You are now ready to Register with the Network. 

CONNECTING WITH THE NETWORK 
Establishing a connection with the network requires the careful orientation of the BGAN terminal towards the 
satellite, a process called pointing. Accurate and precise pointing is important, because a badly-pointed antenna can 
reduce the data rate achievable over the network. When pointing is complete, you can register the terminal with 
the BGAN network. 

CHECKING THE GPS STATUS 

After you have connected your terminal to a computer, you can check the GPS status by opening BGAN 
LaunchPad. Refer to the BGAN LaunchPad status bar and the GPS indicator light on your BGAN terminal for the 
current GPS status. The table below indicates each possible status: 

LaunchPad Status 
bar symbol 

Terminal GPS indicator 
light Status 

 Flashing Green 

The terminal is searching for a GPS fix. Wait until the 
GPS fix has been obtained, and the symbol shown 
below displays. To aid searching, place the terminal in a 
location that has a clear view of as much open sky as 
possible. 

 Solid Green, then Off The terminal has a valid GPS fix. You are ready to 
point the terminal. 

 Flashing Red The terminal needs a GPS fix. The stored GPS fix is no 
longer valid or the network requires an updated fix. 

 Solid Red The GPS receiver in the terminal is faulty. Contact 
your Service Provider. 

If you have not changed location since last registering, the BGAN terminal may be able to use your last valid GPS 
fix. If you have moved location since you last registered you will need to obtain a new GPS fix. 
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POINTING THE TERMINAL 
You can use the BGAN terminal signal strength indicator lights for pointing or if you require detailed pointing 
instructions you should use the BGAN LaunchPad pointing wizard. 

USING THE BGAN LAUNCHPAD POINTING WIZARD 

Use the BGAN LaunchPad Pointing Wizard to step through the process of pointing your terminal, and register 
with the network. To do this open BGAN LaunchPad. The status bar displays the message In Pointing Mode. 

1. Confirm your location is correct in the information box to the left of the map. If your location is not correct, 
you can change it by clicking on the map at your current location or click on nearest city to choose from a list. 
Your location will define the recommended pointing angle and direction.  

 
 

2. Click on Help me setup BGAN.  

3. Step through the instructions to correctly position the terminal. 

 

4. When you are ready to register with the network, click on Register with Network now. Refer to 
Registering with the Network. 
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USING THE BGAN TERMINAL SIGNAL STRENGTH INDICATOR LIGHTS 

To point the antenna using the terminal indicator lights: 

1. Set the angle and position of the BGAN terminal using the compass and the graduated scale. If you do not 
know the angle and position to set the terminal to, use the BGAN LaunchPad pointing wizard.  

Note the Pointing indicator lights as you adjust the compass and graduated scale to obtain the maximum 
possible signal strength. 

 

2. Use the following summary table, outlining the progressive behavior of the indicator lights (going right to left), 
as you try to acquire a satellite signal during pointing. 

 

3. When you are ready to register with the network, click on Register with Network now. Refer to 
Registering with the Network. 

USING THE AUDIO BUZZER 

You can also monitor the signal strength using the audio buzzer. By default the audio buzzer is switched off. To use 
the buzzer when the terminal is in pointing mode: 

1. Press the audio button to turn the buzzer on.  

2. Monitor the signal strength using the buzzer. The higher the pitch and the shorter the interval between tones, 
the stronger the signal. 

 

3. When you are ready to register with the network, click on Register with Network now. Refer to Registering 
with the Network. 

4. When you register with the network, the buzzer turns off automatically.  

Note: If the audio button is pressed when the unit is not in pointing mode, it will have no effect. 
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REGISTERING WITH THE NETWORK 
After you have finished pointing the terminal, click on Register with network now. BGAN LaunchPad will 
automatically open a standard IP data connection after successful registration. The status zone will read Standard 
IP data connection open. BGAN LaunchPad contains the following: 

LAUNCH BAR 

Click on any icon to display the associated tab, where you can perform BGAN LaunchPad functions. 

 
 

The launch bar options include: 

 Data connections − connecting to the Internet to browse Web sites and send and receive emails, and also 
using advanced applications such as video and FTP.  

 Text message options − sending and receiving text messages.  

 Phone options − monitoring call records.  

 Usage information − providing data usage and call duration information.  

 Services information − listing Service Provider support options.  

 Support information − listing LaunchPad help and Service Provider contact details.  
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REGISTRATION STATUS AND COVERAGE MAP 

This area displays the connection date and time, location information and other registration information, and 
shows the expected coverage zone. 

Note: The map depicts BGAN's expectations of coverage, but does not represent a guarantee of service. The 
availability of service at the edge of coverage areas fluctuates depending on various conditions. 

 

 
STATUS BAR 

The Connected to status, terminal Status and Signal strength are all shown on the status bar, as shown 
below: 

 
 

This concludes the QuickStart application. More detailed installation and configuration information is provided in 
the remainder of this guide. 
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 SOFTWARE INSTALLATION 
 

 SUPPORTED OPERATING SYSTEMS 
The Satellite Terminal supports the following Laptop/PC operating systems: 

 Microsoft Windows® XP and 2000 

 Linux Red Hat 9 - KDE 3.1.10 (Kernel Version 2.4.20-8). Note that the terminal’s USB interface is not 
supported with this operating system. 

 Mac 10.x 

 
Note 

You must disconnect any existing LAN connections on your PC before proceeding with installation. 
This avoids any conflict with the network configuration that you are setting up for the Satellite 
Terminal. 

You must verify that the proxy server settings in your browser are disabled. For Microsoft Internet 
Explorer, select Tools / Internet Options / Connections / LAN Settings and uncheck the box labeled 
“Use a proxy server for your LAN.” For Netscape, go to Advanced Preferences and select “Direct 
connection to the Internet.” When complete please close your browser.  DO NOT FORGET TO 
RECHECK THIS BOX ON RETURN TO YOUR OTHER INTERNET CONNECTION. 

 

BGAN LAUNCHPAD CORPORATE EDITION OR PERSONAL EDITION 

You can install either the BGAN LaunchPad Corporate Edition or the BGAN LaunchPad Personal Edition. 

BGAN LaunchPad Personal Edition is for personal use, and has the following properties: 

 All BGAN LaunchPad features are available to you.  

 You can personalize all of BGAN LaunchPad's functions and features without restriction.  
 

BGAN LaunchPad Corporate Edition is for corporate users and has the following properties: 

 A user profile is required with the corporate edition. A user profile is created with a separate application 
called BGAN LaunchPad Corporate Profile Maker.  

 The user profile defines user restrictions so some features may not be available to you, depending on the 
configuration that has been set up by your Corporate IT Manager or service provider.  

 You are asked to enter a username and password when logging in to BGAN LaunchPad.  

 



 

16 BGAN Terminal User's Guide 

 

 INSTALLATION CD AND INSTALLATION WIZARD 
Insert the installation CD into your computer’s CD-ROM drive to initiate the software installation. If the 
Installation Wizard, the program which guides you through the installation process, does not automatically begin, 
use your Windows® Explorer utility or Mac OS X Finder utility to find setup.exe on the installation CD; then, 
double-click that program to start the Installation Wizard. 

The following is a summary of steps to follow in the Installation Wizard: 

1. Insert the Inmarsat BGAN LaunchPad Installation CD into your computer's CD-ROM drive. You will be 
prompted for initial selection of items such as language and acceptance of licensing agreement. 
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2. Choose the correct installation directory for your computer, depending on your operating system, or browse 
for the directory. 

 

 
 

3. For Windows and Mac computers, simply click on the required installer.  

4. Follow the on-screen instructions. Note the following recommended choices: 

 Make sure you select the appropriate Edition -- Corporate or Personal -- when prompted. 
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 Corporate and Personal Edition Instructions: 

− Inmarsat recommends that you select BGAN LaunchPad and Inmarsat TCP PEP when 
prompted. This installs all the programs you need to use BGAN LaunchPad, including TCP PEP. 
When prompted, select BGAN LaunchPad only, and follow the on-screen instructions. 

 
− If you select BGAN LaunchPad and Inmarsat TCP PEP, TCP PEP installs separately after LaunchPad. 

 Special Corporate Edition Instruction: 

− Inmarsat recommends that you install BGAN LaunchPad Profile Manager with the Corporate 
Edition. If you want to install Profile Manager, select Browse CD for any extra features, and follow 
the on-screen instructions.  

5. Other items for selection and installation messages: 

 Shortcut Destination Selection 
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 Pre-Installation Summary 

 
 

 LaunchPad Installation Message 

 
 Installation Complete 
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 FIRST TIME SETUP 
 

 PORTABLE SETUP 

SETTING UP YOUR TERMINAL 

To set up your terminal, you must: 

 Install the USIM/SIM Card and the Battery. 

 Put the Battery on Charge. 

INSTALL THE USIM/SIM 

Your Service Provider will supply you with a Subscriber Identification Module (SIM). The SIM is either a Universal 
Mobile Telecommunications System (UMTS) Subscriber Identification Module (USIM) or a Global System for 
Mobile (GSM) SIM. 

A USIM/SIM is a card commonly used in a GSM phone. The card holds a microchip that stores information and 
encrypts voice and data transmissions, making it close to impossible to listen in on calls. The SIM card also stores 
data that identifies the caller to the network service provider. 

Installation Instructions 

1. Position the MT so that the Satellite Terminal battery door is facing you. 

2. Open the battery door. If you have already installed the battery, release and then remove it. 

 

 

 
3. Push the button on the left-hand side of the USIM/SIM card holder. This releases the holder from its slot. 
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4. Install the USIM/SIM card in the card holder with the gold shield facing up. Snap the card into place in the 
holder. 

 
 

5. With the card in place, orient the holder with the card’s gold shield facing down. Place the holder back in its 
slot in the MT. 

 
6. Put the battery into its slot (positioned as shown below) in the MT and lock it in place. Then close and lock 

the battery door. 

 

 

When you start the BGAN LaunchPad application on your computer (TE) and connect to the Terminal, the 
Terminal will query the current USIM/SIM card to see if the Personal Identification Number (PIN) is enabled. If the 
PIN is enabled, the BGAN LaunchPad displays a PIN window and requires you to enter a valid SIM PIN before 
service is enabled. If the SIM PIN is disabled then the BGAN LaunchPad bypasses this display. 

POWER 

Charging the Battery 

Battery charging will automatically take place as long as the following conditions are satisfied: 

a. The Satellite Terminal is connected to an external power source. 

b. The battery is less than fully charged.  

c. The temperature of the battery is between 0 and 45 degrees C. 

d. The terminal has not detected that the battery is defective. 
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 Insert the battery as shown in the previous section. Battery installation should be carried out after USIM/SIM 
installation (see USIM/SIM installation instructions previously detailed in this section). 

 Plug in the Power Cable and charge the battery for three hours. 

 
 

 
Note 

You can operate the Satellite Terminal while the battery is charging. 

 

AC/DC Adapter 

The AC Mains power adapter (HNS P/N 3003727-0002) is for indoor use only.  It has an indoor operating 
temperature range of -10ºC to +55ºC and provides an output voltage of 20 VDC.  

1. Remove the power adapter from the Satellite Terminal box. 

  
2. Insert the power adapter output connector to the DC Power Input Jack on the back of the Terminal. Insert 

the plug end into any AC outlet between 100 and 240 VAC. 
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TERMINAL STAND POSITIONING 

The positioning of the Satellite Terminal stand at an appropriate angle is very important as a prerequisite for 
getting a fix on the satellite. The Terminal elements used in this process are the stand, knobs, protractor, and 
compass. 

1. Place the Satellite Terminal on a flat surface. Locate the knobs on one end of the unit. Loosen the knobs by 
rotating them both towards the unit. 

 
 

2. To prepare to lift the Terminal, place a finger in the lower right hand corner of the unit and place your other 
hand in the middle of the unit. 

  
 

3. Pull out the front stabilizer. Lay the Terminal back on the flat surface. 
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4. Lift up the Terminal while referring to the protractor on the right-hand side. The protractor gives you the 
angle at which the unit is positioned. Note that an angle of 0 to 45 degrees is displayed on the inside portion 
of the protractor, while a 46 to 90 degree angle is displayed on the outside portion. To start, select an angle 
between 15 and 30 degrees. 

 

 

 

 

  

 

5. After you have positioned the Terminal at the desired angle, tighten the knobs by turning them away from the 
unit. Tighten them so that they are firm and hold the angle but are still movable in case further adjustments 
are needed. Note that both knobs will gradually tighten if you push the unit to a lower angle. This can help 
with locking the unit when the desired protractor angle is close to 90 degrees.  

6. You can now view the compass to prepare for pointing the antenna. Refer to the Antenna Pointing section for 
further instructions. 
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CONNECTING THE SATELLITE TERMINAL TO THE TERMINAL EQUIPMENT (TE) 

INTERFACE CONNECTION PROCEDURES 

1. Choose one of the following interface options to connect your TE to the Satellite Terminal: 

 USB 

 Ethernet 

 Integrated Services Digital Network (ISDN) 

 WLAN 

 

 

 

2. Proceed by following the appropriate set of instructions detailed below for the interface you have chosen. 

 
Note 

There is no need to check the active interface. All interfaces can be used simultaneously 
to accommodate multiple users. 

 

USB 

1. Connect the USB cable to your computer’s USB serial port, and insert the other end of the connector into 
the Terminal’s USB port. 
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2. At the Terminal connection point, slide the cable through the rubber door slot in order to secure and protect 
the connection. 

 

 
Note 

When plugging in the USB cable for the first time, you will see Windows installing a new driver for 
the device. 

 

ETHERNET 

1. Connect the Ethernet cable to your computer’s Ethernet port, and insert the other end of the connector into 
the Terminal’s Ethernet port. 

 
2. At the Terminal connection point, slide the cable through the rubber door slot in order to secure and protect 

the connection. 
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ISDN 

1. Connect the ISDN cable (use the provided Ethernet cable – it is a dual-use cable for both Ethernet and ISDN) 
to your computer’s or phone’s ISDN port, and insert the other end of the connector into the Terminal’s 
ISDN port. 

2. At the Terminal connection point, slide the cable through the rubber door slot in order to secure and protect 
the connection. 

             
 

WLAN 

When the Satellite Terminal is turned on, note that the WLAN LED is green when the Wireless LAN is connected 
and active, and Wireless Encryption Protocol (WEP) is enabled. The WLAN LED is red if WEP is not enabled.  

 
 

OBTAINING A GPS FIX 

Your Satellite Terminal contains an integrated Global Positioning System (GPS) receiver that is used to provide 
location information to the BGAN system. GPS location information is required for system access and the 
reception of a new GPS location is attempted automatically every time the Terminal is powered up. 

The GPS antenna is located in the main Antenna. For optimum GPS signal reception, make sure the Terminal is 
placed in a horizontal position pointed towards the satellite. Since GPS receivers must “see” a large part of the sky 
without obstructions from buildings, mountains or trees, it is necessary to take your Satellite Terminal out to a 
clear space to obtain a new GPS location. It may be possible to obtain a new GPS location in a less favorable 
circumstance, but the time to completion may be longer. 

Once the GPS position is updated, the Satellite Terminal “remembers” your location so the unit can be relocated 
to a more convenient working area, such as inside a building by a window facing the satellite.  

GENERAL INSTRUCTIONS 

1. Take the Satellite Terminal outside and lay it down flat. Verify that the unit has an open view of the sky to get 
a GPS fix. 

2. Power up the Terminal. The GPS LED will start to flash green unless a GPS hardware failure is detected. 

 
3. Monitor either the BGAN LaunchPad GPS indicator or the Terminal’s GPS LED for the quality of the GPS fix. 

This may take a few minutes. Once the GPS fix has been acquired the GPS LED will turn solid green. 
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GETTING THE GPS FIX USING THE LED 

The following is the progression of the GPS LED display as you try to obtain the GPS fix: 

 Getting a fix:  The LED flashing green (½ duty cycle, 1 second period) indicates a 3D GPS fix has not been 
made since the unit was powered on. The current fix may be acceptable in which case the Satellite Terminal 
may register but the LED will continue to flash indicating the MT is still trying to get a 3D fix. 

 Needs a fix:  The LED changes to flashing red (½ duty cycle, 1 second period) indicating that the GPS fix was 
rejected by network or the system determined that a new or more accurate fix is needed based on the 
broadcast GPS Policy Info.  

 Got a fix: The LED changes to solid green when a new 3D GPS fix is obtained. The LED will remain on until 
the unit registers with the network and the fix is accepted. (Note that once the fix is obtained, the GPS unit 
will be turned off unless it is still getting almanac data.) 

 Complete:  The LED turns off when the unit successfully registers with the network and the GPS unit has 
been turned off either because a 3D fix was obtained, or the GPS unit timed out.  

 GPS Failure:  The LED will be solid red if the Terminal detects a hardware fault with the GPS module. 

 

ANTENNA POINTING 

 
Note 

Do not stand in front of the Antenna 

The Satellite Terminal emits radio frequency energy when in the transmit mode. To avoid injury, 
do not place head or other body parts in front of the antenna when system is operational. 

Establishing a new connection requires the careful orientation of the Satellite Terminal towards the BGAN 
Satellite; this procedure is called pointing. The more precisely you point, the faster your data will be sent over the 
network.  

The Terminal provides you with information on the satellite signal strength via the audio pointing aid and LEDs on 
the unit, and the BGAN LaunchPad application on your computer. These displays work simultaneously, and you  
can use either of them. The BGAN LaunchPad can determine the correct azimuth and elevation direction to the 
satellite, which you can use with the compass and protractor integrated on the MT.  

Pointing Using LEDs and Audio Indicator 

1. The terminal’s azimuth and elevation angles can be set using the compass and the protractor, as shown below. 
If you do not know these, then use the BGAN LaunchPad application on your computer. 

 

 

 

2. Note the Pointing LEDs as you adjust the unit to acquire a signal. 
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3. Below is a summary table outlining the progressive behavior of the LEDs (going right to left) as you try to 
acquire a satellite signal during Pointing. 

No Signal 

| 

| 

| 

| 

| 

| 

| 

| 

| 

| 

| 

Best Signal 
 

 

4. If the Audio buzzer is on, the time between tones will get shorter as the satellite signal gets stronger. The 
pitch of the tones will also increase as the signal gets stronger. 

 

 
Note 

The audio buzzer will always default to off when the unit powers on. When the unit is In 
pointing mode, pressing the Audio button located in the front of the terminal turns the buzzer on. 
Pressing it again turns the buzzer off. Once pointing is exited, the buzzer will turn off. If the Audio 
button is pressed when the unit is not in pointing mode, it will have no effect. 

5. If you have pointed the terminal without using the BGAN LaunchPad application, you will need to connect an 
ISDN handset to the terminal and enter #1# on its keypad to exit pointing.  

 

Pointing Using the BGAN LaunchPad 

1. Position the BGAN Terminal. 
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2. Specify Current Location 

 
3. Ensure a Clear View of the Sky 

 
4. Raising the Antenna 

 
5. Compass Reading 
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CONNECTING TO THE NETWORK 

Establishing a connection with the network requires the careful orientation of the BGAN Terminal towards the 
Satellite, a process called pointing. The more precise the pointing, the faster your data can travel over the 
network. When pointing is complete, you can register the Terminal with the BGAN network. 

To register with the network:  

1. Use the LaunchPad Pointing Wizard to step through the process of pointing your Terminal, and register with 
the network. Follow the on-screen instructions for details.  

2. When you are registered with the network, the LaunchPad window displays, containing the following: 

 Launch Bar − click on any icon to display the associated tab, where you can perform LaunchPad 
functions. 

 
 The Launch Bar options include: 

− Data connections − connecting to the Internet to browse Web sites and send and receive emails, 
and also using advanced applications such as video and FTP. Refer to About Data for details. 

− Phone Options − monitoring call records. Refer to About Phone for details.  

− Text Message Options − sending and receiving text messages. Refer to About Text for details. 

− Usage information − providing data usage and call duration information. Refer to Monitoring Usage 
for details.  

− Services information − listing Service Provider support options. Refer to Using Services for details. 

− Support information − listing LaunchPad help and Service Provider contact details. Refer to Using 
Support for details. 

 Registration status – displays the connection date and time, location information and other registration 
information, as shown below: 
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 Connected to status, Terminal Status and Signal strength – all shown on the status bar, as shown 
below: 

 

 Launch Bar − click on any icon to display the associated tab, where you can perform LaunchPad 
functions. 

− Refer to Monitoring Alarm Status for details on the Connected to information. 

− Refer to Monitoring Terminal Status for details on the Status information. 

− Refer to Monitoring Signal Strength for details on the Signal strength information. 
 

Inmarsat recommends that you use LaunchPad’s Pointing Wizard to point your Terminal to the satellite. You can 
also point your Terminal using the Terminal’s indicator lights and audio indicator. 
 

Once the terminal has been pointed to the satellite, then a suitable handset can be connected to the terminal for 
voice calls to be made. Any ISDN handset can be used by connecting it to the ISDN port, using the supplied ISDN 
cable. Alternatively, analog handsets can be used with a suitable ISDN Terminal Adaptor. To ensure that voice calls 
can also be made to the terminal’s handset, ensure that the ISDN handset, or the ISDN Terminal Adaptor, is 
programmed with an MSN of 1. The instruction manual supplied with this equipment will describe how to do this. 

 

 FIXED/SEMI-FIXED INSTALLATION 
The satellite terminal can be mounted to a pole or flat surface (such as a wall our roof) using the Fixed Installation 
Accessory Kit. This kit includes all the installation brackets, mounting hardware, tools and instructions to complete 
the installation, including mounting the terminal so that it is always correctly pointed at the satellite. The terminal 
can then be left alone for an extended period of time without having to be re-pointed or set-up. The Fixed 
Installation Accessory Kit can be re-used to install the terminal is different locations. 

When mounted in a  location where access to the terminal may not be straightforward (for example, mounted 
high on a wall), you may want the terminal to recover automatically after a power outage. To permit this, the 
following automatic mode settings are recommended (see the Automatic Mode section for more details): 

 Auto “on” mode is enabled 

 LED off mode is enabled 

 Antenna pointing bypass is enabled 

 Automatic context activation is enabled 

 SIM PIN entry is disabled 

In addition, it is recommended that the battery be removed to prevent it being damaged at extreme temperatures. 
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 TERMINAL OVERVIEW 
 

 SIZE AND WEIGHT 
The Satellite Terminal is 27.5 cm x 34.5 cm x 5.0 cm.  Its weight is 2.8 kg (including the battery). 

The small size and weight allows you to easily move it from site to site, and it can be connected at a new site in 
minutes. 

 TERMINAL INTERFACES AVAILABLE 

INTERFACE OVERVIEW AND DEFAULTS 

The Satellite Terminal includes four interfaces for connecting to your computer.  

 Ethernet 

 USB 

 ISDN (for voice and data) 

 WLAN (IEEE 802.11) 

By default the ISDN, USB and Ethernet interfaces are active when the unit is turned on. The 802.11 Wireless LAN 
(WLAN) interface is disabled by factory default, but by using the BGAN LaunchPad you can configure the WLAN 
to be on at startup. 

When the Terminal is connected to a DC power source, such as mains, the ISDN interface remains on at all times. 
When running from the battery, the ISDN interface will turn off 5 minutes after pointing is completed if no ISDN 
device is connected. You can re-enable the ISDN interface from the BGAN LaunchPad if you subsequently need to 
connect an ISDN device. This saves power and maximizes operating times because the power sourcing circuitry 
draws significant current even if no device is connected. If an ISDN device is connected at power up and then 
disconnected before the timer expires, the ISDN port will power off.  

You can configure the WLAN interface to be on, off or auto-detect for T minutes. It behaves the same on DC 
power and battery, since turning off is for security as well as power savings. After time T, the WLAN interface can 
be reactivated by changing the interface to “On” in the BGAN LaunchPad. 

The following table summarizes the interface on/off behavior during battery and DC Power operation. 

Interface Battery Operation DC Power Operation 

USB On On 

Ethernet On On 

ISDN On. 

Note:  After 5 minutes if no ISDN 
device detected, turn off. 

On 

Off (default) Off Off 

Once Enabled On On 

WLAN 
Configuration 
Options 

Auto (time T) 

Default 5 
mins. 

On. 

Note:  After T minutes if no 
WLAN device detected, turn off. 

On. 

Note:  After T minutes if no 
WLAN device detected, turn off. 
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ESTABLISHING COMMUNICATIONS BETWEEN COMPUTER AND SATELLITE TERMINAL  

ETHERNET 

Ethernet communications are established by connecting your computer Ethernet LAN port directly to the Satellite 
Terminal LAN port via the supplied Ethernet cable and monitoring the BGAN LaunchPad for the connection.  

USB 

USB communications are established by connecting your computer USB port directly to the Satellite Terminal 
LAN port via the supplied USB cable and monitoring the BGAN LaunchPad for the connection.  

ISDN 

ISDN communications are established by connecting your computer ISDN port directly to the Satellite Terminal 
LAN port via the supplied ISDN cable (same as the Ethernet cable) and monitoring the BGAN LaunchPad for the 
connection.  

With the ISDN interface you can make voice or data calls and can perform limited BGAN LaunchPad functions. 
Only one terminal at a time may make a call since only one B channel is supported per Terminal in the BGAN 
system. However, up to four ISDN phones may be utilized with the one ISDN connection. Note that this limit is 
imposed by the current limit function in order to protect Ethernet devices in case they are accidentally connected 
to the ISDN port. 

WLAN 

The WLAN function is used in access point mode. You can use the BGAN LaunchPad to configure (at least) the 
following parameters: 

 Wireless LAN interface on/off. The default is off. 

 Network name. The default is “BGAN” but the user can change it. 

 Channel number. This controls the channel number (1-14) used by the access point. Depending on the 
country only certain subsets of these channels may be used (4 options: FCC, ETSI, France or Japan). Channel 
11 is common to almost all regulatory options and so it is used as the default. 

 Encryption 
 

Up to eleven WLAN users can utilize the Satellite Terminal simultaneously.  
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 TERMINAL FEATURES 

USIM/SIM CARD 

 
The USIM contains an identity that unambiguously identifies a subscriber. The USIM provides storage for 
subscription and subscriber related information.  

The User-to-USIM authentication feature restricts access to the USIM until the USIM has authenticated the user. 
Thus, access to the USIM can be restricted to an authorized user or number of users. Your USIM Personal 
Identification Number (PIN) is stored securely in the USIM. The entry of a correct PIN opens access to the USIM. 

The USIM-Terminal Link authentication feature ensures that access to a terminal or other user equipment can be 
restricted to an authorized USIM. The USIM and the terminal share a code stored securely in the USIM and the 
terminal. If a USIM fails to prove its knowledge of the code, it is denied access to the terminal. 

If the USIM is removed during operation, the terminal will deactivate any active PDP contexts, detach from the 
network, and enter a "NO SIM" operational mode. If the USIM is reinserted while the MT is still on, the MT must 
be restarted to detect the new or replaced USIM. 

BATTERY 

Hughes Network Systems Part Number 3003702-0001 

 
The standard battery is a rechargeable lithium ion battery pack. An optional extended lithium ion battery pack 
(same form factor) is also available for purchase. 

Battery charging can take place as long as the following conditions are satisfied: 

 The Satellite Terminal is connected to an external power source. 

 The battery is less than fully charged.  

 The temperature of the battery is within 0 to 45 degrees C. 

 The battery has not been found by software to be defective. 

The Satellite Terminal contains battery charging circuitry that will automatically charge the battery whenever the 
unit is plugged into DC power. 



 

36 BGAN Terminal User's Guide 

BUTTONS 

The Satellite Terminal has two buttons:  

 

 
 The Power button is used for turning the unit on or off. A “long” press of the button when the unit is off 

turns it on, and a long press of the button when the unit is on turns it off. 

 The Audio button is used for switching the audio tones on and off. These tones are useful during pointing 
mode (see description later in the Guide). A “short” press of the button accomplishes this. 

INDICATOR LIGHTS (LEDS) AND AUDIO BUZZER 

The LEDs and Audio Buzzer serve as indicators for the status of the Satellite Terminal. The figures below illustrate 
where the LEDs are located on the MT and the functions of each. 

POWER LED 

 

 

The Power LED indicates power status.  

Light Status 

Off Terminal is turned off. 

Green Terminal is powered on. 

Flashing Red Fault detected. 

Flashing Green Operating on battery power. Also when Power button is pressed to turn unit 
off and it is being powered down. 
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BATTERY LED 

 
The Battery LED indicates battery status. The indicators are different when the Terminal is on DC power as 
opposed to on battery power. 

Light DC Power -- Status 

Off No battery. 

Green Battery fully charged. 

Flashing Green Battery charging. 

Flashing Red Battery Fault – not charging 

Light Battery Power -- Status 

Off Unit is off. 

Green Terminal on, in pointing mode. 

Flashing Green Terminal on, pointing completed. 

Flashing Red 
(fast) 

Terminal on, battery low (Power LED is green) 

Flashing Red 
(slow) 

Terminal on, battery fault detected (Power LED is also flashing red) 

 

POINTING LEDS  

 
These six, two-color LEDs have significance for two events:  System Power-Up/Boot-Up and Antenna Pointing. 

Initially, all LEDs are off. On power on, the power LED turns green. As the Satellite Terminal progresses through 
the boot sequence, pointing LEDs 2 through 6 (right to left progression) turn green. 

If the boot completes successfully, the LEDs turn off and resume their normal function. 

These LEDs also indicate the signal quality during antenna pointing. The LEDs are intended only as a guide for 
accuracy – the audio tones or BGAN LaunchPad application must be used for full accuracy (see the Antenna 
Pointing section in the First Time Setup chapter). During the Terminal power-up and boot, the six pointing 
LEDs on the unit indicate boot progress. Upon successful boot-up, the LEDs switch to indicate antenna pointing 
status or turn off if pointing is bypassed. The first (rightmost) pointing LED is not used during this process to avoid 
confusion with pointing displays. 
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WIRELESS LAN LED  

 

 
 This LED is not lit during Power-Up or if Wireless LAN is turned off. 

 It is green if Wireless LAN is on and Wireless Encryption Protocol (WEP) is enabled. 

 It is red if Wireless LAN is on and WEP is disabled. 

 If Wireless LAN is enabled and the MT is operating off battery power, the LED flashes at 1/8 duty cycle 1-
second period to save power, after the unit exits pointing. 
 

GPS LED  

 
The GPS unit in the Satellite Terminal will attempt to get a 3D fix each time the unit powers up. The GPS LED 
indicates the state of the GPS fix. See Obtaining a GPS Fix section. 

AUDIO BUZZER 

An audio buzzer is used to indicate the signal quality during antenna pointing. If the Audio buzzer is on, the tones 
act like those of a Geiger counter:  a long time between tones if the signal is weak and a faster rate of tones as the 
signal is acquired. 

The buzzer will always default to off when the unit powers on. Pressing the Audio button in pointing mode turns 
the buzzer on. Pressing it again turns the buzzer off. Once you exit pointing, the buzzer will turn off. If the Audio 
button is pressed when the unit is not in pointing mode, it will have no effect. 
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COMPASS 

 
Reference the compass during the Antenna Pointing process to get the correct Compass Direction needed for the 
antenna. During this process, the BGAN LaunchPad instructs you in which direction to point the antenna. 

 
Note 

The compass can be affected when close to magnetic fields or metallic objects. 

 

SOLAR PANEL COMPATIBILITY 

The terminal is compatible with solar panels. The easiest way to interface to a solar panel is through the HNS 
supplied DC Power Adapter (HNS P/N 3004065-0001). The output of the DC power adapter is plugged into the 
terminal, with the input (cigarette lighter adaptor) connected to the output of the solar panel. 

The terminal has been tested to work with the following solar panels: 

 IDG T-60 (3 panels) form IDG Europe (60W max, 3.3A at max power) 

 SunCatcher F0001 (2 panels) from Powerline Electronics Accessories (14.5W max) 

 

 TERMINAL ACCESSORIES 
Terminal accessories include: 

 DC Power Adapter 

 Extended Battery 

 AC Mains Power Adapter (w/30mm Cable) 

 Cables 

 Compatible Devices 

 Fixed Installation Kit 

Each is described in this section. 
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DC POWER ADAPTER 

 
The DC power adaptor (HNS P/N 3004065-0001) can be purchased through Hughes Network Systems. It has an 
operating temperature range of -25ºC to +55ºC and provides an output voltage of 20 VDC. It can be used with 
input voltages in the range 10 to 32VDC. 

EXTENDED BATTERY 

 
The Extended lithium ion battery pack (HNS P/N 3003702-0002) can be purchased through Hughes Network 
Systems. The Extended battery pack has the same form factor as the standard battery pack, with 50% more 
capacity.   

AC MAINS POWER ADAPTER (W/30MM CABLE) 

 
AC Mains power adapter (HNS P/N 3003727-0001) is for indoor use only.  It has an indoor operating temperature 
range of 0ºC to +40ºC and provides an output voltage of 20 VDC. 

When the Satellite Terminal is first connected to AC Mains power, the unit powers on immediately. Note that 
when the Terminal is attached to AC Mains power, the unit still supports battery charging while it is turned off. 
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CABLES 

The Satellite Terminal package comes with a USB cable and cables that provide Ethernet and ISDN connections. 

 USB cable (HNS P/N 3003027-0001)  

 

 Ethernet/ISDN 10 meter cable (HNS P/N 3003692-
0001) 

 

 

When the Terminal is connected to a PC or laptop it uses a regular Ethernet cable. If the Terminal is connected to 
a LAN hub, a "switchover" LAN cable is required. 

COMPATIBLE DEVICES 

The terminal has been successfully tested with the following ISDN handsets: 

 ASCOM Eurit 33 plus 

 SwissVoice Eurit 25   

 ISDN handset supplied with the NERA BGAN terminal 

 Siemens Gigaset SX255 

FIXED INSTALLATION KIT 

The following items are found in the fixed installation kit. Note that you are responsible for mounting the 
hardware at a fixed site. 

 Fixed Mount Screws (Theft-Proof) (HNS Part #: 3004066-0001) 

 
 

 30-Meter Cord for AC Mains (HNS Part #: 3003750-0001) 
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 Ethernet/ISDN 30 meter cable (HNS Part # 3003692-0002) 
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 BGAN LAUNCHPAD OVERVIEW 
The BGAN Man-Machine Interface (BGAN LaunchPad) allows you to view and manage the terminal’s operations 
and status via a user-friendly set of tools installed on your computer.  

Here is the Launch Pad screen upon system start-up. 

 

 

 PIN CODE ENTRY 
When the BGAN LaunchPad is started and connects to the Satellite Terminal, the terminal queries the current SIM 
card to see if the SIM PIN is enabled.  If the SIM PIN is enabled, the BGAN LaunchPad displays a SIM PIN window 
and requires you to enter a valid SIM PIN before service is enabled.   

 
 

If the SIM PIN is disabled then the BGAN LaunchPad will bypass this display. 

 

 PERSONALIZATION 
After the PIN check, if Personalization is enabled and any checks fail, the BGAN LaunchPad displays the Security 
window and requires you to enter a valid depersonalization code before access to further functions is allowed. If 
all Personalization checks pass, the terminal will bypass the Security window. 

 

 POINTING 
After the PIN and Personalization checks, the pointing screen is displayed. Once you have completed pointing, click 
the Connect button to exit pointing and connect to the network. 



 

44 BGAN Terminal User's Guide 

See the section on Antenna Pointing: Pointing Using the BGAN LaunchPad for details on how to utilize the Pointing 
Screen. 

 

 MAIN DISPLAY 
Once all the initial checks have been completed, the main BGAN LaunchPad page is displayed, showing progress 
towards acquiring the network. 

 
 

 MULTIPLE USERS 
Up to 11 users attached to the Ethernet, USB and Wireless LAN interfaces can access the BGAN LaunchPad at 
the same time. Each user establishes a TCP connection to the Satellite Terminal.  

In a multi-user scenario, it is advisable to have one user do all MT configuration changes to avoid confusion; other 
users could use an BGAN LaunchPad profile that prevents configuration changes.  
 

 SOFTWARE DOWNLOAD/UPGRADE 
Upgrading the terminal’s software is a two-phase process controlled by an “Upgrader” function in the BGAN 
LaunchPad. The Upgrader is accessed from a drop down menu in the BGAN LaunchPad. 

During the first phase, the terminal software is downloaded from a common Network location (i.e., an Internet 
HTTP/FTP server) to your computer. The computer may utilize the BGAN network or any other accessible 
network to obtain the new software image.  

In the second phase, the Upgrader copies the software from your computer, stores it in the satellite terminal, and 
then installs it on the satellite terminal. If the upgrade fails, the old software is available on your computer and can 
be re-downloaded to the satellite terminal. 
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CONNECTING TERMINAL TO PC AND OTHER DEVICES VIA WLAN 
INTERFACE 

PC 

The terminal provides a WLAN interface to any computer which operates in the same frequency band.  

 When the Satellite Terminal is operating on main power, the WLAN interface will always be activated. 

 When the Satellite Terminal is operating on battery, the WLAN interface will be turned off after five minutes 
of inactivity.   

The WLAN interface is configurable via the BGAN LaunchPad, as follows: 

1. From the BGAN LaunchPad main menu, select Terminal > WLAN Interface Settings. The Configure 
WLAN Interface dialog box is then displayed: 

 

 
2. Select Enable to activate the WLAN interface. 

3. Enter a Network Name (SSID). The default is BGAN, but you can change this if required. 

4. Select a Region from the drop-down list. 

5. Select a Channel number from the drop-down list. This controls the channel number (1-14) used by the 
access point. Depending on the country only certain options are available for selection. Channel 11 is common 
to almost all regulatory options, and so is the default. 

6. Select a WEP Key Length from the drop-down list. There are two key lengths available, 64 bit and 128 bit. 
128 bit offers a higher level of security, but may cause a slight decrease in performance.  

7. Select an WEP Key Format at the Enter WEP key in: text box. This can be either Hex or ASCII. Hex 
keys use hexadecimal numbers (0-9, A-F) to encrypt and decrypt data, and are the most widely supported 
format. Plain text (ASCII) keys are supported on some operating systems (check that your operating system 
supports ASCII before you select this option). 

8. Enter up to four WEP Keys. The format depends on whether you selected Hex or ASCII.  

 Hex – Enter a two digit hexadecimal number (0-9, A-F) in each box on the WEP Key 1 row. You can enter 
up to four keys in total, and you should change the default key periodically for added security. 
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 ASCII – Enter a string of 5 characters for 64 bit encryption, or 13 characters for 128 bit encryption. You 
can enter up to four keys in total, and you should change the default key periodically for added security. 

Note: Check that each key that you set up here is exactly the same as each key on your Access Point. 
That is, WEP Key 1 on the LaunchPad must be the same as Key 1 on the Access Point and so on. 

9. Click OK to save the changes, Cancel to exit without saving, or Apply to apply the settings for this WLAN 
session only. 

The following table summarizes the default settings. 
 

Parameter Description Default 

Wireless access Turn on/off 
WLAN Interface 

Disabled 

Network Name 
(SSID) Sets the SSID BGAN 

Region Region of 
Operation 

Rest of the world 

Channel Wireless Channel 
of Operation 

11 

WEP Security Turn on/off  WEP 
Security 

Off 

WEP Keys [1-4] Four WEP Keys None 

Key Selection Selects the WEP 
Key 

No key selected 

The MT does not provide MAC Filtering as a security option. 

ISDN EQUIPMENT 

You can establish ISDN data communication by connecting your ISDN equipment directly to the BGAN Terminal 
ISDN port via the supplied ISDN cable (which is the same as the Ethernet cable). To activate ISDN, and set MSN 
numbering options, perform the following steps: 

1. From BGAN LaunchPad main menu, select Terminal > ISDN Interface Settings. The Configure ISDN 
Interface dialog box is then displayed: 
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2. Select the Enable Interface check box to activate the ISDN interface, or uncheck the check box to 

deactivate the interface. 

3. For a 4 kbps speech call, enter MSN 1 into the MSN Speech number: text box. Typically, this is the option 
you use if you have an ISDN handset connected to the ISDN port. 

4. For a 3.1 KHz audio call, enter MSN 2 into the MSN Audio number: text box. Typically, this is the option 
you use if you are connecting a fax machine to the ISDN port. 

5. For an Unrestricted Digital Information (UDI) call (64 kbps ISDN), enter MSN 3 into the MSN UDI 
number: text box. Check the documentation supplied with your device for details on whether it is a UDI 
device. 

6. For a Restricted Digital Information (RDI) call (56 kbps ISDN), enter MSN 3 into the MSN RDI 
number: text box. Check the documentation supplied with your device for details on whether it is an RDI 
device. 

7. Click OK to save the changes, or Cancel to exit without saving. 
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 BGAN SERVICES 
 

 VOICE TELEPHONY SERVICES 
You can make and receive voice calls using the BGAN Satellite IP Terminal. To do this, you have to connect a 
phone handset. You can use two general types of phone handsets; either an ISDN handset, or a 2-wire analog 
handset with an ISDN terminal adaptor.  

Before you can use your handset for voice services, you have to program its MSN (mobile subscriber number) to 
1. This identifies the handset to the BGAN Satellite IP Terminal. The handset’s instruction manual will explain how 
to do this. Note: you can make emergency calls without the correct MSN programmed into the handset. 

 

 SUPPLEMENTARY SERVICES 
Supplementary Services have to be provisioned by the Service Provider before they can be used. Please verify with 
your Service Provider which services are available with your subscription. 

You access the Supplementary Services via key-presses on the ISDN terminal. The key-presses consist of the 
following formatA one or two digit activation code 

 A one or two digit activation code 

 A two or three digit service code 

 Optional parameters preceded by a * keypress 

The entry is terminated by a # keypress 

The activation codes use the * and # characters as defined in the following table: 

 

 
The optional parameters are as defined in the following table: 

Parameter Description 
*DN Directory Number 

*T Timeout (5-30 seconds) 

*PW Password 

 
The following table shows all available Supplementary Services: 

Supplementary 
Service 

Description String 

CLIP Calling Line Identification Presentation - Interrogation  *#30# 

CLIR Calling Line Identification Restriction - Deactivate for a single call 
(see note) 

*31#Number# 

CLIR Calling Line Identification Restriction - Activate for a single call  (see 
note) 

#31#Number# 

CLIR Calling Line Identification Restriction - Interrogation  *#31# 

COLP Connected Line Identification Presentation - Interrogation  *#76# 

COLR Connected Line Identification Restriction - Interrogation  *#77# 

Activation Code Description 
* and ** Registration 

* Activation 
# Deactivation 
*# Interrogation 
## Erasure 
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Supplementary 
Service 

Description String 

CFU Call Forwarding Unconditional - Registration  *21*DN*# 

CFU Call Forwarding Unconditional - Registration  **21*DN*# 

CFU Call Forwarding Unconditional - Erasure  ##21**# 

CFU Call Forwarding Unconditional - Activation  *21**#  

CFU Call Forwarding Unconditional - Deactivation  #21**#  

CFU Call Forwarding Unconditional - Interrogation  *#21**# 

CFNRc Call Forwarding on Mobile Subscriber Not Reachable - Registration  *62*DN*# 

CFNRc Call Forwarding on Mobile Subscriber Not Reachable - Registration  **62*DN*# 

CFNRc Call Forwarding on Mobile Subscriber Not Reachable - Erasure  ##62**# 

CFNRc Call Forwarding on Mobile Subscriber Not Reachable - Activation  *62**# 

CFNRc Call Forwarding on Mobile Subscriber Not Reachable – 
Deactivation  

#62**# 

CFNRc Call Forwarding on Mobile Subscriber Not Reachable - 
Interrogation  

*#62**# 

CFB Call Forwarding on Mobile Subscriber Busy - Registration  *67*DN*# 

CFB Call Forwarding on Mobile Subscriber Busy - Registration  **67*DN*# 

CFB Call Forwarding on Mobile Subscriber Busy - Erasure  ##67**# 

CFB Call Forwarding on Mobile Subscriber Busy - Activation  *67**#  

CFB Call Forwarding on Mobile Subscriber Busy - Deactivation  #67**#  

CFB Call Forwarding on Mobile Subscriber Busy - Interrogation  *#67**#  

CFNRy Call Forwarding on No Reply - Registration  *61*DN**T# 

CFNRy Call Forwarding on No Reply - Registration  **61*DN**T# 

CFNRy Call Forwarding on No Reply - Erasure  ##61**# 

CFNRy Call Forwarding on No Reply - Activation  *61**# 

CFNRy Call Forwarding on No Reply - Deactivation  #61**# 

CFNRy Call Forwarding on No Reply - Interrogation  *#61**# 

CW Call Waiting - Activation  *43# 

CW Call Waiting - Deactivation  #43# 

CW Call Waiting - Interrogation *#43# 

BAOC Barring of All Outgoing Calls - Registration  *33*PW*# 

BAOC Barring of All Outgoing Calls - Registration  **33*PW*# 

BAOC Barring of All Outgoing Calls - Activation  *33*PW*# 

BAOC Barring of All Outgoing Calls - Deactivation  #33*PW*# 

BAOC Barring of All Outgoing Calls - Interrogation  *#33*PW*# 

BAIC Barring of All Incoming Calls - Registration  *35*PW*# 

BAIC Barring of All Incoming Calls - Registration  **35*PW*# 

BAIC Barring of All Incoming Calls - Activation  *35*PW*# 

BAIC Barring of All Incoming Calls - Deactivation  #35*PW*# 

BAIC Barring of All Incoming Calls - Interrogation  *#35*PW*# 
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Supplementary 
Service 

Description String 

BOIC Barring of Outgoing International Calls - Registration  *331*PW*# 

BOIC Barring of Outgoing International Calls - Registration  **331*PW*# 

BOIC Barring of Outgoing International Calls - Activation  *331*PW*# 

BOIC Barring of Outgoing International Calls - Deactivation  #331*PW*# 

BOIC Barring of Outgoing International Calls - Interrogation  *#331*PW*# 

 

Example:  

If you want to forward all incoming calls to a number (0015554529550 in this example), you must activate the Call 
Forwarding, Unconditional supplementary service. 

 Format:  *21*DN*# 

 Key-presses: *21*0015554529550*# 
 

If you want to cancel Call Forwarding, you must deactivate this supplementary service. 

 Key-presses: #21**# 
 

If you want to forward incoming calls to a number (0015554529550 in this example) if they are not answered 
within 20 seconds, you must activate the Call Forwarding on No Reply supplementary service. 

 Format:  *61*DN**T# 

 Key-presses: *61*0015554529550**20# 
 

If you want to cancel Call Forwarding on No Reply, you must deactivate this supplementary service. 

 Key-presses: #61**# 



 

BGAN Terminal User's Guide 51 

 

 MESSAGING SERVICES 

SHORT MESSAGE SERVICE (SMS) VIA BGAN LAUNCHPAD 

The BGAN Satellite Terminal supports Short Message Service (SMS) capabilities. The Short Message Service 
handles point-to-point messages and comprises two basic services: 

 SM MT (Short Message Mobile Terminated) 

 SM MO (Short Message Mobile Originated). 

The text messages to be transferred by SM MT or SM MO can contain up to 140 octets. The number of bytes 
actually transmitted within an SMS message is dependent on the message size. 

 
Note 

SMS Messages can be read, edited, created, and sent via the SMS Application in the 
BGAN LaunchPad. You cannot access SMS from an ISDN Handset or any other ISDN 
equipment. 

 

 DATA SERVICES 
LaunchPad provides a variety of connection options to help ensure that all your data requirements are met. 
LaunchPad is configured with five connections by default. You can edit these default connections or add to them by 
setting up any number of customized connections, called dedicated connections, using a simple to use configuration 
tool. 

DEFAULT CONNECTIONS 

Of the five default types of data connections available from the launch bar, there are one standard and four 
streaming. 

 Standard: A standard connection is charged per Mb. You are charged only for the transmitted data. The 
bandwidth you are allocated depends on terminal type and network availability, but is always ‘best effort’, that 
is, you are allocated bandwidth depending on your requirements and the requirements of other users of the 
BGAN network, or BGAN Terminal. This connection class is suitable for most data types, other than 
multimedia. 

 Streaming: A streaming connection is charged by time. You are charged for the amount of time the 
connection is active. Streaming enables multimedia data, such as video, to be sent in a continuous data stream 
and converted into sound and pictures. The bandwidth required for a streaming connection is difficult to 
predict, and depends on factors such as length of connection and number of receivers. 

The standard connection is suitable for most basic data requirements, and is charged by the amount of data sent. If 
you require a guaranteed data rate for your connection, to eliminate delay for example, you can connect using one 
of the four streaming connections, at the following data rates: 

 32 kbps streaming 

 64 kbps streaming 

 128 kbps streaming 

 256 kbps streaming 
 

Each streaming class connection is charged by the length of time that the connection is live. 

The standard connection and four streaming connections are primary connections and are alternatives to each 
other, that is only one can be open at a time. You must close one connection before you can open another.  
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DEDICATED STREAMING CONNECTIONS 

If required, you can set up one or more dedicated streaming connections for applications such as live video and 
FTP. A dedicated streaming connection ensures that a selected application does not have to share the connection 
with any other traffic. The Terminal supports up to ten dedicated connections alongside the primary connection. A 
dedicated streaming connection is charged by the length of time that the connection is live.  

LaunchPad displays an information note if you are about to open a streaming connection, or open two or more 
connections at the same time. Refer to About PDP Contexts for details on how LaunchPad manages data 
connections. 

VPNS 

If you require extra security when transmitting data, you can add a VPN connection to LaunchPad, and use this 
connection to run a VPN application on your computer. When your VPN connection is open and the VPN 
application is running, communications between LaunchPad and the Terminal are closed down. Therefore, when a 
VPN connection is open, information about the Terminal does not display on the LaunchPad status bar. 

ISDN DATA 

Data can be sent and received via the ISDN interface on the BGAN IP Terminal. To make use of this service, you 
will need to connect a piece of ISDN terminal equipment. Examples of ISDN equipment are ISDN cards in PCs or 
MACs, ISDN AudioVideo cameras and video-conferencing systems, ISDN group 4 fax machines. 

To use the ISDN equipment with the BGAN IP Terminal, you first have to program 1 of 3 MSNs (mobile 
subscriber numbers) into the equipment.  

The number you program depends on the capability of your ISDN equipment: 

 For equipment that sends and receives data as 3.1 KHz audio, such as group 3 fax machines, use program 2. 

 For equipment that sends and receives data either as Unrestricted Digital Information (UDI), or Restricted 
Digital Information (RDI). use program 3. 
 

Refer to the instructions supplied with the ISDN equipment for information on the equipment capability and how 
to program the appropriate MSN. 

When you have completed the prograBGAN LaunchPadng, you can then connect the ISDN equipment to the 
ISDN jack on the Satellite Terminal. You are then ready to access ISDN Data Services from the ISDN equipment. 
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OPENING DATA CONNECTIONS  

Data connections can be opened, added and managed from the Data Connections tab. To open the Data 
Connections tab, click on the Data icon in launch bar. The Data Connections tab opens, as shown below: 

 
From this window, you can do the following: 

Open and Close Connections 

 Open a Data Connection 

 Close a Data Connection 

 Open a VPN − only available if you have configured a VPN. Refer to Add a VPN for details. 

 Close a VPN − only available if you have configured a VPN. 

Add a Dedicated Streaming Connection 

 Add a Data Connection 

Add a VPN 

 Add a VPN 

Manage Connections 

 View Data Connections 

 Delete a Data Connection 

 Change the icon order 

 Hide an icon 

The following option is also available, but not managed from the Data Connections window: 

 Opening an ISDN Data Connection 

OPENING AND CLOSING A CONNECTION 

OPENING A DATA CONNECTION 

To open a data connection, click on the Data icon in the launch bar to open the Data Connections tab. All the 
available data connections are displayed. You can select one primary connection, and as many secondary 
connections as you require. 
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OPENING A STANDARD CONNECTION 

To open the standard connection: 

1. If a primary Streaming connection is open, close this connection by double-clicking on the Streaming 
connection icon. The message The Primary PDP context has been closed displays. Click on OK to close this 
dialog box. 

2. In the Data Connections window, double-click on the Standard connection icon. The message Primary PDP 
Context has been established successfully displays. 

3. Click on OK to continue. 

OPENING A STREAMING CONNECTION 

To open a primary streaming connection: 

1. If the standard connection is open, close this connection by double-clicking on the Standard connection 
icon. The message The Primary PDP context has been closed displays. Click on OK to close this dialog box. 

2. In the Data Connections window, double-click on a Streaming connection icon. The following dialog box 
displays: 

 
3. Click on Yes to open the Premium connection. The message Primary PDP Context has been established 

successfully displays. 

4. Click on OK to continue. 
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 OPENING A DEDICATED STREAMING CONNECTION 
To open a dedicated streaming connection: 

1. Double-click on the Dedicated connection icon that you want to open. The following dialog box displays: 

 
2. Click on OK to continue. This opens a dedicated connection alongside your current primary connection. You 

can open as many secondary connections, that is dedicated connections, as required in this way. 

CLOSING A DATA CONNECTION 

To close a data connection, do any of the following: 

 Click on the connection in the Data Connections tab. The connection icon loses its outline, indicating that 
the connection is closed. 

 In the Data Connections tab, click on the View all data connections in terminal button to display the 
BGAN Connections window. You can then either click on Close All to close all the currently active 
connections, or click on Close alongside the connection or connections you want to shut down.  
 
Note: If you are sharing the BGAN Terminal, clicking on Close All closes the connections of other Terminal 
users.  

 In the LaunchPad main menu, select BGAN Services > Close All Data Connections. The Close all 
satellite connections dialog box displays, where you have the option to select Close All My Data Connections 
or Close all Data Connections for All Users. 

Note: If you are sharing the BGAN Terminal, clicking on Close All Data Connections for All Users 
closes the connections of other Terminal users. 

SET UP OR EDIT A VPN CONNECTION 

A VPN connection differs from other data connections in that only the VPN connection can be open when a VPN 
application is running. LaunchPad closes all other functionality related to the Terminal while a VPN connection is 
open and a VPN application is running. For this reason, you must carefully select when to open a VPN connection, 
so that other operations are not affected. 

To configure a VPN icon and VPN icon name, and launch an application with the VPN icon: 

To configure a VPN icon and VPN icon name, and launch an application with the VPN icon: 
1. Click on the Data icon in the launch bar to display the Data Connections tab. 

2. Click on Advanced to display the Connection Configuration window. 

3. Click on Add New VPN or select a VPN connection and click on Edit, the VPN Icon Setup window displays. 

4. Click on the General tab. The VPN Icon Setup - General screen displays, as shown below:  
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5. Select an icon. The icon displays in the box next to the Icon label text box. 

6. Type in a name for the VPN connection in the Icon label text box. The name and icon that you select here will 
display when you open the Data tab in LaunchPad. 

7. Check the Launch VPN on selection check box to launch a particular application when you click on this 
VPN icon in LaunchPad. For example, you may want to launch Internet Explorer when you select this VPN 
icon. 

8. Use the Browse button to search for the file name of the application you want to launch with this VPN icon 
(or if you know the file name, enter it in the Path text box). When you open this VPN connection in 
LaunchPad, the application automatically opens. You must close the application before you can close this 
connection. 

9. Click on Apply to save the displayed configuration, and continue editing the connection, click on OK to save 
the displayed configuration and exit the configuration screens, or click on Cancel to edit without saving. 

10. You can then configure the VPN Connection Quality and Routing Options by clicking the VPN Quality or 
Routing tabs in the VPN Icon Setup window. The way to do this is identical to other data connections. For 
full details, see Configuring Connection Quality and Setting Up Routing Options in the Adding Or Editing A Dedicated 
Connection section below. 

OPENING A VPN 

To open a VPN connection and run a VPN application: 

Double-click on the VPN icon in the Data Connections window.  

11. Click on OK to continue. This opens the VPN connection ready for you to open a VPN application, and 
closes all other connections. Note the following: 

 All other data connections remain unavailable until you close the VPN application and the VPN connection.  

 The Status section of the status bar indicates that there is No Open Connection, and the Connected to 
and Signal strength sections of the status bar do not display any Terminal information. 
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 Launch Pad closes all other functionality related to the Terminal whilst the VPN application and VPN 
connection is open. 

12. Open the VPN application on your computer. 

Note: If you selected a VPN application when Setting Up an Icon, this application automatically launches 
when you open the VPN connection.  

CLOSING A VPN 

A VPN differs from other data connections in that the LaunchPad closes the interface with the Terminal whilst the 
VPN connection is open and the VPN application is running. For this reason, you must close your VPN application 
and reconnect to the Terminal when you want to return to normal LaunchPad functionality. 

To close a VPN: 

13. Close the VPN application on your computer. 

14. In the LaunchPad status bar, click on Search for BGAN Terminal. The LaunchPad closes the VPN 
connection, re-connects to the Terminal, and opens a standard data connection. The process is the same as if 
the Terminal was Registering with the Network for the first time. 

You can now use all LaunchPad features. 
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 ADDING OR EDITING A DEDICATED CONNECTION 

SETTING UP AN ICON 

To configure an icon and icon name, and launch an application with the icon: 

1. Click on the Data icon in the launch bar to display the Data Connections tab. 

2. Click on Advanced to display the Connection Configuration window. 

3. Click on Add New Connection if you want to set up a new connection, or click on Edit Configuration if 
you want to edit an existing connection. The Connection Icon Setup window displays. 

4. Click on the Icon tab. The Connection Icon Setup  screen displays, as shown below: 

 

5. Select an icon. The icon displays in the box next to the Icon label text box. 

6. Type in a name for the connection in the Icon label text box. The name and icon that you select here will 
display when you open the Data tab in LaunchPad. 

7. Check the Launch an application with this selection check box to launch a particular application when 
you click on this icon in LaunchPad. For example, you may want to launch Internet Explorer when you select 
this icon. 

8. Use the Browse button to search for the file name of the application you want to launch with this icon (or if 
you know the file name, enter it in the Path text box). When you open this connection in LaunchPad, the 
application automatically opens. You must close the application before you can close this connection. 

9. Click on Apply to save the displayed configuration, and continue editing the connection, click on OK to save 
the displayed configuration and exit the configuration screens, or click on Cancel to edit without saving. 
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CONFIGURING CONNECTION QUALITY 

To configure the Connection quality for a data connection: 

1. Either: 

 From the Connection Icon Setup window, click on the Connection quality tab. Or 

 From Launch Pad: 

− Click on the Data icon in the launch bar to display the Data Connections tab. 

− Click on Advanced to display the Connection Icon Setup window. 

− Click on Add New Connection if you want to create a new connection, or select an icon and click 
on Edit Configuration if you want to edit an existing connection. The Connection Icon Setup 
window displays. 

− Click on the Connection tab. The Connection Icon Setup - Connection window displays, as 
shown below: 

 

2. Select a Connection class. This can be either Standard, Streaming or Dedicated. 

 If you chose Standard, no further configuration is required in this window. 

 If you choose Streaming, the Streaming Parameters section of the window activates. 

 If you choose Dedicated, the Application template drop-down list and the Streaming Parameters 
section of the window activates. 

3. If you choose Streaming or Dedicated, you can do the following in the Streaming Parameters section of the 
window:  

 Select the Desired Symmetrical Rate from the drop-down list. 

 Select the Minimum Symmetrical Rate from the drop-down list. 

 Check the Use error correction check box if you want to turn error correction on. 

4. If you choose Dedicated, select an application template from the Application template drop-down list. This 
associates an application with this connection, and enables the Terminal to correctly route certain types of 
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traffic. For example, if you want the traffic from a selected FTP application be routed through this dedicated 
connection, select the FTP template from the drop-down list.  

5. Click on Apply to save the displayed configuration, and continue editing the connection, click on OK to save 
the displayed configuration and exit the configuration screens, or click on Cancel to edit without saving. 

SETTING UP ROUTING OPTIONS  

To configure the Routing options for a data connection: 

1. Either: 

 From the Connection Icon Setup window, click on the Routing tab. Or 

 From Launch Pad: 

− Click on the Data icon in the launch bar to display the Data Connections tab. 

− Click on Advanced to display the Connection Configuration window. 

− Click on Add New Connection if you want to create a new connection, or click on Edit 
Configuration if you want to edit an existing connection. The Connection Icon Setup window 
displays. 

− Click on the Routing tab. The Connection Icon Setup - Routing window displays, as shown 
below: 

 

2. If the drop-down box is activated, select an APN from the Select APN drop-down list. If it is not activated, 
only the default APN is available. 

3. In the IP Configuration section, set up your IP Address requirements. Select either Use Dynamic (Network 
Assigned IP Address) or Use Static IP Address. If you select Use Static IP Address, enter the IP 
Address in the text box. 

4. In the IP Configuration section, set up your DNS Server requirements. Select either Use Dynamic 
(Network Assigned) DNS Servers or Use Static DNS Server. If you select Use Static DNS Server, 
enter a Primary DNS Server and, if required, a Secondary DNS Server in the text box.  

5. If required, check the Use Header compression check box to turn on header compression. 
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6. If required, check the Use VPN with this connection check box, and select a VPN from the drop-down 
list. 

7. Click on Apply to save the displayed configuration, and continue editing the connection, click on OK to save 
the displayed configuration and exit the configuration screens, or click on Cancel to edit without saving. 

 

 MANAGING CONNECTIONS 

OPENING AN ISDN DATA CONNECTION 

Data can be sent and received via the ISDN interface on the Terminal. To make use of this service, you must 
connect an ISDN device to the Terminal. Examples of ISDN devices are ISDN cards in PCs or MACs, ISDN 
AudioVideo cameras and ISDN fax machines. 

To use the ISDN device with the Terminal: 

1. Program an MSN (Mobile Subscriber Number) into the device. The number you use depends on the capability 
of your ISDN device. 

 If the device sends and receives data as 3.1KHz audio, such as Group 3 fax machines, use MSN 2. 

 The device sends and receives data as Unrestricted Digital Information (UDI) or as Restricted Digital 
Information (RDI), use MSN 3. 

Refer to the instructions supplied with your ISDN device for information on its capability, and how to 
program the appropriate MSN. 

2. Make sure that the ISDN interface is set up in LaunchPad. Refer to Setting up the ISDN Interface for details. 

3. Connect the ISDN device to the ISDN jack on the BGAN Terminal.  
 

You are now ready to access ISDN Data Services. 
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 SERVICE FEATURES 
 

 AUTOMATIC MODE 
The Satellite Terminal includes four automatic options: auto power on, LED on/off, antenna pointing bypass, and 
automatic context activation. You can set all of these options with the BGAN LaunchPad. 

AUTO “ON” MODE 

When the Satellite Terminal is mounted on a pole, the power switch may be inaccessible; this can be a problem if 
there is a power failure since the unit will turn off and will not turn back on when power is applied. You could use 
the unit with a battery to provide battery backup in case of power failure. However, in extreme weather 
conditions a battery could be damaged and should not be used.  

To handle pole mount or other fixed installation, you can activate an auto on configuration feature. With auto on 
enabled, if DC power is applied, the unit turns on as if the power key was pressed. If the power key is pressed 
while the unit is on with this feature enabled, it will still power off. To power back on, you can use the power key, 
or you can disconnect and reconnect DC power to create a rising edge on the power input. The default 
configuration of the Satellite Terminal is for auto on to be disabled. 

The auto on feature can be used in conjunction with antenna pointing bypass to allow the Satellite Terminal to 
automatically recover from a power outage (assuming PIN, etc are disabled). 

LED ON/OFF MODE 

In a semi-fixed installation, you can use this option to operate with all LEDs off to make your unit and operation 
less conspicuous. 

ANTENNA POINTING BYPASS 

You can configure a pointing bypass option that causes the unit to skip the pointing phase. The unit then performs 
spot beam selection, registration and network connection. This option should only be used for fixed installations 
where pointing is not required on subsequent power ups. With this option active, if the unit is moved or the signal 
attenuated, the unit will remain in global beam scan until the problem is fixed and the global beam acquired. After 
acquiring the global beam the Satellite Terminal automatically continues with PSAB acquisition. 

AUTOMATIC CONTEXT ACTIVATION 

If you have enabled automatic context activation, the Satellite Terminal automatically activates a PDP context when 
it sees data destined for the network from a private IP address for which there is no context.  

The “context create” request uses the default Access Point Name (APN), username and password stored in the 
Satellite Terminal. You can modify these parameters using the BGAN LaunchPad. “Subscribed” QoS is requested 
and a dynamic network assigned IP address requested (“global” address). 

 

 PHONEBOOK 
BGAN supports a phonebook feature to facilitate the management of phone numbers.  

There are 3 phonebooks: a phonebook stored on your computer (with 250 entries), the USIM global phonebook, 
and the USIM application local phonebook. You can work with any of the three phonebooks. The active 
phonebook can be saved as a file on the TE. Files on the TE can be read into the application and then written back 
to the USIM. 
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 EMERGENCY CALLS 
If you want to make an emergency call from the ISDN handset (or analog handset plus ISDN terminal adaptor) and 
you do not know the PIN code, you can point the terminal using the audio tones or LEDs and then enter the 
connect command #1# from the handset. This causes the Satellite Terminal to exit pointing, but not to register 
with the network. When you enter a recognized emergency number, the Satellite Terminal then makes an 
emergency call without having to register with the network. If the Satellite Terminal is configured for pointing 
bypass, you do not have to enter the connect command; instead, simply enter the emergency number from the 
handset. 

 

 PERSONALIZATION SERVICES 
The personalization features store information in your computer and check this information against the SIM/USIM 
whenever the Satellite Terminal is powered up or a SIM/USIM is inserted. If a check fails, the Satellite Terminal 
enters the "limited service state" in which only emergency calls can be attempted. You can enter depersonalization 
codes to deactivate these checks and progress to normal mode. 

The Satellite Terminal performs personalization checks after completion of initialization and checking for the SIM 
PIN. The following types of personalization services are available: 

 Network Personalization: Allows the network operator to personalize a Satellite Terminal so that it can 
only be used with that particular network operator's SIM/USIMs. 

 Network Subset Personalization: A refinement of network personalization, which allows network 
operators to limit the usage of a Satellite Terminal to a subset of SIM/USIMs. 

 Service Provider (SP) Personalization: Allows the service provider to personalize a Satellite Terminal so 
that it can only be used with that particular service provider's SIM/USIMs. 

 Corporate Personalization: Allows a corporate customer to personalize Satellite Terminals that it 
provides for its employees or customers use so that they can only be used with the company's own 
SIM/USIMs. 

 SIM/USIM Personalization: Enables a user to personalize a piece of mobile equipment so that it may only 
be used with particular SIM/USIM(s). 

 

 PDP CONTEXTS OVERVIEW 

PDP CONTEXTS – PRIMARY AND SECONDARY 

Resource management for BGAN is based on PDP contexts, or connections. This means that in congested 
networks each user needs his or her own context to ensure a fair allocation of bandwidth from the network. 
Therefore, the Satellite Terminal creates a PDP context for each connected computer that has traffic to send over 
the network. The multiple contexts can be primary or secondary, but there are benefits to using primary contexts. 

 Primary contexts can connect to different APNs each with an individual username and password. This is useful 
because each APN will only support a single set of subscribed Quality of Service (QoS) values. 

 Primary contexts each get their own global IP address. 

The total number of primary and secondary contexts that the Satellite Terminal can support is 11. For example, it 
can support 5 primary and 6 secondary contexts, but not six primary and 6 secondary contexts. 

You can configure the Satellite Terminal to enable or disable automatic context activation. Even if automatic 
context activation is used, you can still manually control contexts for flexibility and exception conditions. 

Primary Context 

The Satellite Terminal creates a primary context with the entered information. If a primary context already exists 
for your local IP address, the current context is deleted before creating the new one. This could happen if a 
context was created automatically and the user wants to change to a different APN or QoS. Your BGAN 
LaunchPad indicates whether the context is successfully created or displays any errors. 
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A disconnect option is also provided to allow you to tear down their context. This is useful if a streaming context 
was created, or to free contexts if other users need to connect. If a user with an automatically created context 
disconnects from the BGAN LaunchPad, their context is deleted.  

If multiple users are connected to a router with DHCP and a NAT, and the router is connected to the Satellite 
Terminal, all the users have a single IP address and so share a single PDP context. This gives flexibility in case 
charges are by IP address/PDP context. 

Secondary Context 

Secondary contexts can be set-up from the BGAN LaunchPad, and are associated with a primary context. 
Secondary contexts might be used, for example, when multiple applications on one TE are started, and the TE’s 
primary context has already been set-up. 

Each secondary contexts requires a Traffic Flow Template to be configured, which defines how the data for the 
secondary context should be routed. This is done through the BGAN LaunchPad. 

IP ADDRESSING 

Connections between each TE and the terminal are achieved with private IP addresses, and between the terminal 
and the BGAN network with global addresses. 

Private addresses can be dynamically assigned by the DHCP server in the terminal, starting from192.168.128.101. 
They can also be statically configured from the TE (via the BGAN LaunchPad), in which case addresses in the range 
192.168.128.1 through 192.168.128.254 can be used. 

The global address of the terminal is assigned by the Network Service Provider, and can be either static or 
dynamic.  Dynamic global address configuration is automatically carried out by the mechanism in the terminal that 
activates contexts. Static global address configuration is carried out by the user via the BGAN LaunchPad on the 
TE, by entering a static address provided by the Network Service Provider. 

 

 MULTIPLE USERS 
Up to 11 computers can be connected to the BGAN terminal using the Ethernet, WLAN and USB interfaces. 

More than one TE can be connected to the Ethernet interface by using either a hub or router. If a hub is used, the 
BGAN terminal will allocate private IP addresses to each TE connected to the hub, and so each TE will be able to 
have a primary PDP context. If a router (which includes a NAT) is used, the whole private network would appear 
as a single device to the BGAN terminal, and so the TEs connected to the router will share a single primary PDP 
context. The NAT in the router would assign IP addresses within its own subnet. 

Multiple computers connected via the WLAN interface will each be allocated a private IP address. 
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 MANAGING CONTACTS 
The Contacts window enables you to manage your Phone and Text contacts. You can add a new contact, edit or 
delete an existing contact. In addition, you can exported a contact to a file on your computer, or import a contact 
from any file on the computer.  

The Contacts screen shown below displays when you click on the Phone icon or the Text icon on the launch bar. 

 
Contacts displayed in this window are stored in the BGAN SIM. You can also select the All tab to view all contact 
names.  

From this window you can: 

 Create or Add a New Contact 

 Edit a Contact 

 Export a Contact to a File 

 Export a Contact to an Address Book 

 Import a Contact from a File 
 

Click on a contact name in the Contacts column to display the details of the contact alongside.  

You can also search for a contact by typing in the first few letters of the contact name in the Search text box, and 
then click on Go. The Contacts list scrolls down to the closest matching name as you type. 
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ADDING AND EDITING CONTACTS 

This section explains how to add, edit or delete a contact. 

ADDING A CONTACT 

To add a contact to an address book: 

1. Click on New in the Contacts window. The following screen displays: 

 
2. Enter the name of the contact on the first line. 

3. Enter the contact number at the Tel: prompt. 

4. Click on Save to save the contact details. 

EDITING A CONTACT 

To edit an existing contact: 

1. Select the contact to be edited and click on Edit. The following screen displays: 

 
2. Edit the name or the contact number of the contact. 

3. Click on Save to save the contact details. 



 

BGAN Terminal User's Guide 67 

DELETING A CONTACT 

To delete a contact:  

1. Select a contact or contacts from any of the phone books.  

2. Click on Delete. You are asked to confirm the deletion. 

3. Click on Yes to confirm, or No to return to the Contacts window. 

EXPORTING AND IMPORTING CONTACTS 

This section explains how to export a contact to a file on your computer, and import a contact from a file on your 
computer. 

EXPORTING A CONTACT 

You can export a contact or contacts to a file on your computer.  

EXPORTING TO A FILE  

To export a contact to a file: 

1. Select the contact to be exported and click on Export. The Choose Export Type dialog box displays, as 
shown below: 

 
2. Check the File check box to export the contact to a file on your computer.  

3. Click on Continue. 

4. The Save dialog box displays. Navigate through your computer’s file structure using this window, and click 
Save to save the contact details. 
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IMPORTING A CONTACT 

You can import a contact from a file on your computer. To do this: 

1. Click on Import. The Open dialog box displays. 

2. Navigate through your computer’s file structure using this window, and click Open to select the contact 
details you want to import. The Select Address Book dialog box displays, as shown below: 

 
3. Check the BGAN SIM check box to import the contact to the BGAN SIM. 

4. Click OK to import. 
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 TCP PEP SOFTWARE 
Transmission Control Protocol (TCP) enables two hosts, usually computers to establish a connection and 
exchange data. It improves the efficiency of data transfer by dividing the data into packets, then delivering the 
packets in the same order that they were sent. 

TCP with Performance Enhancing Proxies (TCP PEP) enhances the performance of TCP over a satellite network 
such as the BGAN network by providing: 

 Fast start − useful for transferring small amounts of data, since traditional TCP is often slow with smaller 
data transfers. 

 Increased window size − improves TCP performance in larger bandwidth applications. 

 Delay based congestion control − ensures high transfer rates and less delay. 
 

TCP PEP is automatically installed during the Standard installation of LaunchPad, or you can install TCP PEP 
separately from the installation CD. By default, TCP PEP is enabled in the BGAN Terminal. 

You can enable or disable TCP PEP, and monitor any errors, using the TCP Accelerator screen.  

 From BGAN Launch Pad main menu, select Settings > TCP Accelerator. The TCP Accelerator screen is 
then displayed: 
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 EXIT, RESET AND RESTART FEATURES 

EXITING LAUNCHPAD 

Before you can exit LaunchPad, you must close all currently active connections. Refer to Closing a Data Connection 
or Closing a Connection in Multi-User Mode for details. 

Once you have closed all connections, you can exit LaunchPad as follows: 

1. Click File > Exit BGAN LaunchPad. The Shutdown Confirmation dialog box displays: 

 

2. Click Yes to confirm shutdown, or No to cancel. 

RESETTING THE TERMINAL 

If you have the required access privileges, you can reset all the configuration settings of the Terminal to the factory 
default. Note that your current settings are lost during the reset. 

To reset the terminal to factory default: 

1. Select the Terminal > Reset to Factory Default option on LaunchPad main menu. The Reset to Factory 
Default dialog box displays, as shown below: 

 

2. Enter the security code in the Security Code text box. 

3. Click on OK to reset the terminal, or click on Cancel to exit without resetting. 

RESTARTING THE TERMINAL 

You may want to restart the terminal if an error occurs.  

To restart the terminal: 

1. Select Terminal > Restart Terminal from the LaunchPad main menu. The Restart BGAN Terminal dialog 
box displays, as shown below: 

 

2. Click on OK to restart the terminal, or click on Cancel to exit without restarting. 
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 GETTING HELP 
Support for the BGAN Satellite Terminal is provided via the following help options: 

 Using Services 

 Using Support 

 Using Diagnostics 

 Using LaunchPad Help 

 Viewing Properties 

 
 

 BGAN PROFILE MANAGER 

ABOUT PROFILE MANAGER 

Note: The Profile Manager is only available to users of the Corporate Edition of LaunchPad. 

The Profile Manager enables the BGAN LaunchPad Administrator to create and edit user profiles, and so 
customize BGAN LaunchPad to your organization's requirements. Using the Profile Manager, you can quickly and 
easily configure connections, apply user restrictions and set up the customer support details available from within 
BGAN LaunchPad. This enables you to manage the functionality of BGAN LaunchPad, and gives you more control 
over how BGAN LaunchPad is used.  

Note the following about the Profile Manager: 

 You can configure and create user profiles for use either on a standalone PC, or across a network of users. 

 You can create an unlimited number of user profiles.  

 All user profiles are held in the Profile Manager Image Library, stored on a network-shared drive of the 
computer. 

Profile Manager is installed automatically when you install the Corporate Edition of BGAN LaunchPad. Refer to 
Installing Corporate Edition for details. 
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CREATING AND EDITING A PROFILE 

CONFIGURING A PROFILE 

When you open the Profile Manager, the General tab is active, and the default profile is displayed, as shown below: 

 
Note the following when creating or editing a connection: 

 If at any time you want to clear all the existing settings for a profile, click on the File menu, and select New. 
You will be asked to confirm the operation. Click Yes to confirm. 

 You must go into each of the tabs in Profile Manager, and complete all mandatory fields, before you can save 
the profile. 

 When you first open Profile Manager, the default profile, if any, is displayed. 
 

To create a connection: 

1. Configure a Connection. 

2. Configure Restrictions. 

3. Configure Support Details. 

4. Configure User Information. 
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CONFIGURING A CONNECTION 

This section describes how to set up a connection. To do this: 

1. In Profile Manager, select the Connections tab. The Connections screen displays, as shown below: 
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2. Either: 

 To add a new connection, click on Add new connection. Or: 

 To edit an existing connection, select the icon that you want to edit, and click on Edit configuration. Or: 

 To add a VPN, click on Add new VPN. 

The Connection icon setup screen displays, as shown below: 

 

The Connection icon setup window has three components, as follows: 

 Icon 

 Connection Quality 

 Routing 

CONFIGURING AN ICON 

To configure an icon: 

1. Select an icon. The icon displays in the box next to the icon label text box. 

2. Type in a name for the connection in the icon label text box. The name and icon that you select here will 
display when you open the Data tab in BGAN LaunchPad. 

3. Check Launch Application on selection check box to launch a particular application when you click on 
this icon in BGAN LaunchPad. For example, you may want to launch Internet Explorer when you select this 
icon. 

4. Use the Browse button to search for the file name of the application you want to launch with this icon (or if 
you know the file name, enter it in the Path text box). When you open this connection in BGAN LaunchPad, 
the application automatically opens. You must close the application before you can close this connection. 

5. Click on Apply to save the displayed configuration, and continue editing the connection, click on OK to save 
the displayed configuration and exit the configuration screens, or click on Cancel to edit without saving. 
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CONFIGURING CONNECTION QUALITY 

To configure the Connection quality for a data connection: 

From the Connection Icon Setup window, click on the Connection quality tab. The Connection Icon Setup - 
Connection quality window displays, as shown below: 

 

1. Select a Connection class. This can be either Standard, Streaming or Dedicated. Note that Dedicated does 
not display if you are configuring a VPN. 

 If you chose Standard, no further configuration is required in this window. 

 If you choose Streaming, the Streaming Parameters section of the window activates. 

 If you choose Dedicated, the Application template drop-down list and the Streaming Parameters section of 
the window activates. 

2. If you choose Streaming or Dedicated, you can do the following in the Streaming Parameters section of 
the window:  

 Select the Desired Symmetrical Rate from the drop-down list. 

 Select the Minimum Symmetrical Rate from the drop-down list. 

 Check the Use error correction check box if you want to turn error correction on. 

3. If you choose Dedicated, select an application template (also known as a traffic flow template) from the 
Application template drop-down list. This associates an application with this connection, and enables the 
Terminal to correctly route certain types of traffic. For example, if you want the traffic from a selected FTP 
application be routed through this dedicated connection, select the FTP template from the drop-down list.  

4. Click on Apply to save the displayed configuration, and continue editing the connection, click on OK to save 
the displayed configuration and exit the configuration screens, or click on Cancel to edit without saving. 
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CONFIGURING ROUTING OPTIONS 

To configure the Routing options for a data connection: 

From the Connection Icon Setup window, click on the Routing tab. The Connection Icon Setup - Routing 
window displays, as shown below: 

 

1. If the drop-down box is activated, select an APN from the Select APN drop-down list. If it is not activated, 
only the default APN is available. 

2. In the IP Configuration section, set up your IP Address requirements. Select either Use Dynamic 
(Network Assigned IP Address) or Use Static IP Address. If you select Use Static IP Address, enter the IP 
Address in the text box. 

3. In the IP Configuration section, set up your DNS Server requirements. Select either Use Dynamic 
(Network Assigned) DNS Servers or Use Static DNS Server. If you select Use Static DNS Server, enter a 
Primary DNS Server and, if required, a Secondary DNS Server in the text box.  

4. If required, check the Use Header compression check box to turn on header compression. 

5. If required, check the Use VPN with this connection check box, and select a VPN from the drop-down 
list. 
 
Note: This option does not display if you are configuring a VPN connection using Profile Manager. 

6. Click on Apply to save the displayed configuration, and continue editing the connection, click on OK to save 
the displayed configuration and exit the configuration screens, or click on Cancel to edit without saving. 
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CONFIGURING RESTRICTIONS 

Using the Settings tab, you can set restrictions on the selected profile. 

To set restrictions: 

1. Click on the Settings tab. The Settings screen displays, as shown below: 

 
2. Select one of the radio buttons. The options are as follows: 

 No restriction – the BGAN LaunchPad user can change the connection and BGAN device settings. 

 Medium restriction – the BGAN LaunchPad user cannot change connection settings, but can change 
BGAN device settings. 

 Maximum restriction – the BGAN LaunchPad user cannot change connection settings or BGAN device 
settings. 

3. If required, check the Disable control of all open connections in a device check box. The ensures that 
users cannot edit connections owned by other users. 

4. Click Save to save the displayed configuration and exit from the Settings window. 
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CONFIGURING SUPPORT DETAILS 

Using the Support tab, you can set the Support contact details that will display on BGAN Launch Pad. 

To set support details: 

1. Click on the Support tab. The Support window displays, as shown below: 

 
2. Either: 

 If no user support is available, click on the No user support available check box, or, 

 Enter the details of the available user support in the Email, Website and Telephone number text 
boxes. If one of these options is not available, click the appropriate None Available check box. 

3. Click Save to save the displayed configuration and exit from the Support window. 
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CONFIGURING USER INFORMATION 

After you have completed all screens in the Profile Manager and clicked on Save, the User Information window 
displays, as shown below: 

 
This window enables you to create a user login for use with this profile, or to create multiple profiles with 
different user logins. 

To create a user login for the current profile: 

1. Type a user name in the User name text box. 

2. Type a password in the Password text box. 

Either: 

 If you only require one user login for this profile, click Save. A dialog box opens enabling you to save the 
login in a selected directory; or 

 If you want to add in additional profiles with different user logins, click the Create multiple different 
images with different user names and passwords check box. An Add button displays beneath the 
Password text box. 

3. Click Add. The user login displays in the login table. 

4. Repeat steps 1, 2 and 4 for each additional profile you want to create. 

5. Click Save when you have created all required logins. A dialog box open enabling you to save the logins in a 
selected directory. 

IMPORTING A USER LOGIN 

If required, you can import a user login. 

To import a user login, in the User information window: 

1. Click on Import. The Open dialog box displays. 

2. Navigate to the directory where the profile is stored, select the required login and click Open.  

3. The user login is imported into the login table. 
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EXPORTING A USER LOGIN 

If required, you can export a user login. 

To export a user login, in the User information window: 

1. Click on the user login you want to export, and click Export. The Save dialog box displays. 

2. Navigate to the required directory, and click Save. 

MANAGING PROFILES 

CHANGING THE ICON ORDER 

The available data connections display in the BGAN LaunchPad Data connections window. You can change the 
sequence in which the icons displays using Profile Manager. 

To change the icon sequence: 

1. In Profile Manager, click on the Connections tab. 

2. Select an icon you want to move, and use the Move Left and Move Right buttons to move the icon to its 
new position in the sequence. 
Note: If you want to move an icon more then one place to the right or left, you must select the icon each 
time before using the arrow keys. 

3. If required, repeat step 2 for any other icon you want to move. 

DELETING A DATA CONNECTION 

To delete a connection: 

1. In Profile Manager, click on the Connections tab. 

2. Select an icon from the Existing icons screen. 

3. Click on Delete. You are prompted to confirm the deletion. 

4. Click on Yes to confirm the deletion, or click on No to exit without deletion. 

HIDING AN ICON 

The available data connections display in the BGAN LaunchPad Data connections window. You can hide an icon if 
required using Profile Manager. 

To hide an icon: 

1. In Profile Manager, click on the Connections tab. 

2. Select an icon you want to hide, and select the Hide icon radio button. The selected icon is grayed out, and 
does not display when you open the BGAN LaunchPad Data connections window.  
Note: To restore the icon, repeat step 2 and deselect the Hide icon radio button. 

3. If required, repeat step 2 for any other icon you want to hide. 
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 SECURITY 

ABOUT SECURITY AND CONTROL 

Using BGAN LaunchPad, you can change the SIM PIN and facility password, and enable a PIN to give a high level of 
management control over security. 

The Security and Control options are as follows: 

 Changing the SIM PIN and Facility Password 

 Enabling a PIN 

CHANGING THE SIM PIN AND FACILITY PASSWORD 

Using BGAN LaunchPad, you can change the SIM PIN and facility password. 

CHANGING THE SIM PIN 

To change the SIM PIN: 

1. From the LaunchPad main menu, select Terminal > Change PINs. The Change PINs dialog box displays: 

 

2. Select the Change SIM PIN radio button. 

3. Enter the current pin in the Existing Pin/Password text box. 

4. Enter the new pin in the New Pin/Password text box, then re-enter the new pin in the Confirm 
Pin/Password text box. 

5. Click on Ok to save the changes, or Cancel to exit without saving. 
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CHANGING THE FACILITY PASSWORD 

You can set a password for selected phone facilities, such as all incoming calls or all outgoing calls. 

To set or change a Facility Password: 

1. From Launch Pad main menu, select Terminal > Change PINs. The Change PINs dialog box displays: 

 

2. Select the Change Facility Password radio button. 

3. Select the facility for which you want to change the password from the Select Facility drop-down list. 

4. Enter the current password in the Existing Pin/Password text box. 

5. Enter the new password in the New Pin/Password text box, then re-enter the new password in the 
Confirm Pin/Password text box. 

6. Click on OK to save the changes, or Cancel to exit without saving. 

ENABLING A PIN 

Using BGAN LaunchPad you can enable or disable a configured PIN. 

To enable a PIN: 

1. From Launch Pad main menu, select Terminal > Require PINs. The Require PIN dialog box displays: 

 

2. From the Select PIN drop-down list, select the facility for which you want to enable or disable the PIN. 

3. Click on the Enable radio button to enable the PIN, or click on the Disable radio button to disable the PIN. 
Before you can disable the PIN, you must enter the current PIN in the Enable PIN text box. 

4. Click on OK to save the changes and exit, or click on Cancel to exit without saving the changes. 
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 SOFTWARE UPGRADE 
BGAN LaunchPad can check for software updates for the LaunchPad, terminal and other software. It can check for 
these updates using the BGAN system or a terrestrial connection, and be scheduled to check for updates daily, 
weekly or monthly.  

BGAN LaunchPad can also install the appropriate software to the terminal or computer. 

CHECKING FOR UPDATES 

You can set the types of upgrade you want BGAN LaunchPad to check for, and how to check. 

1. From BGAN LaunchPad main menu, select Update > Check for Updates. The Check for Updates screen is 
then displayed: 

 

2. From the Check every drop-down list, select how often you want BGAN LaunchPad to check for updates. 
The options are Daily, Weekly or Monthly. Alternatively, click on Check for updates now. 

3. In the Check for update to: section, choose which software types you want to check for. For example, if 
you do not want to check for updates to third party software, uncheck the Other 3rd party software and 
drivers check box. By default, BGAN LaunchPad checks for all software upgrades. 

4. In the BGAN or LAN connection section, choose whether you want to check for updates when there is a 
LAN connection (terrestrial), a BGAN connection (satellite), or when both connections are active. 

5. Click Apply to save the settings, or Cancel to exit without saving. 

SOFTWARE VERSIONS AND AVAILABILITY 

You can install the software upgrades that LaunchPad has found.  

1. From BGAN LaunchPad main menu, select Update > Versions and Availability. The following screen 
is then displayed: 
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2. Scroll down to view which software you want to install on the terminal or on your computer.  

3. Then click on Download now to begin the installation. 

4. LaunchPad will inform you when the download has completed. 

Note: make sure that a loss of power will not interrupt the download process. You should install the 
terminal’s battery and fully charge it, in case there is a power outage; and connect the AC/DC or DC/DC 
adaptor in case the battery runs flat during the download. Similarly, if your computer is operating from a 
battery, make sure the battery is charged and connect the computer’s AC/DC adaptor or charger. 

 

 LOG FILES 
BGAN LaunchPad maintains log files that detail the commands sent to the Terminal, and the responses obtained 
from the terminal. BGAN LaunchPad also records any unsolicited events reported by the terminal. LaunchPad 
maintains three types of log file: 

 Event log file – reports details of all command and responses exchanged between BGAN LaunchPad and the 
Terminal. 

 Network log file – reports network activity-related information, such as network usage, QoS information, and 
unsolicited alerts reported by the network. 

 Terminal log file – generated by the terminal, and can be accessed from LaunchPad. 

You can do the following for any of these log files: 

 Delete or Clear a Log File. 

 Display a Log File. 

 E-mail a Log File. 

 Print a Log File. 

 Save a Log File. 
 

In addition, for event logs and network logs you can: 

 Turn Logging On and Off. 
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DELETING OR CLEARING LOG FILES 

You can delete an event log file or a network log file, and clear a terminal log file from BGAN LaunchPad main 
menu.  

EVENT LOGGING 

To delete an event log file from your computer, do the following from BGAN LaunchPad main menu: 

1. Select File > Event Log File. The Event Log dialog box displays, as shown below: 

 

2. Select a log file from the Select event log file drop-down list. 

3. Click on Delete. The log file is deleted from your computer. 

NETWORK LOGGING 

To delete a network log file from your computer, do the following from BGAN LaunchPad main menu: 

1. Select File > Network Log File. The Network Log dialog box displays, as shown below: 

 

2. Select a log file from the Select network log file drop-down list. 

3. Click on Delete. The log file is deleted from your computer. 
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TERMINAL LOGGING 

To clear a BGAN log file from your computer, do the following from BGAN LaunchPad main menu: 

1. Select File > Terminal Log File. The BGAN Terminal Log File Management dialog box displays, as 
shown below: 

 

2. Select a log file from the Select BGAN terminal log file drop-down list. 

3. Click on Clear. The log file is cleared from your computer. 
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DISPLAYING LOG FILES 

You can display the event log file, the network log file or the BGAN log file from BGAN LaunchPad main menu.  

EVENT LOGGING 

To display event logging, do the following from BGAN LaunchPad main menu: 

1. Select File > Event Log File. The Event Log dialog box displays, as shown below: 

 

2. Click on Display. The Log Display Dialog displays, as shown below: 

 

3. Check the Turn logging on/off check box to turn logging on, or uncheck the check box to turn logging off. 

4. Click OK to save the change. 
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NETWORK LOGGING 

To display network logging, do the following from BGAN LaunchPad main menu: 

1. Select File > Network Log File. The Network Log dialog box displays, as shown below: 

 

2. Click on Display. The Log Display Dialog displays, as shown below: 

 

3. Check the Turn logging on/off check box to turn logging on, or uncheck the check box to turn logging off. 

4. Click OK to save the change. 
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TERMINAL LOGGING 

When displaying the log file contents of the terminal log file, you have the option to view full log file contents or 
only specific number of lines. To display terminal logging, from the LaunchPad main menu 

1. Select File > Terminal Log. The BGAN Terminal Log File Management dialog box displays, as shown 
below: 

 

2. Your choice: 

 If you want to display all the lines in the log file, check the Retrieve all lines of log file check box. Or, 

 If you want to display selected lines in the log file, uncheck Retrieve all lines of log file check box, and 
enter the number of lines you want to retrieve in the Number of lines to retrieve from BGAN 
terminal text box. 

3. Click on Display. The Log Display Dialog displays, as shown below 

 

4. Click OK to save the change. 
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EMAILING LOG FILES 

You can email the event log file, the network log file or the BGAN log file from BGAN LaunchPad main menu.  

EVENT LOGGING 

To email the event log file, do the following from BGAN LaunchPad main menu: 

1. Select File > Event Log File. The Event Log dialog box displays, as shown below: 

 

2. Select the file to email from the Select event log file: drop down list. 

3. Click on E-Mail to open a new message in your Email application, addressed to your support contact and with 
the log file attached. You can type in a message, if required. 

NETWORK LOGGING 

To email the network log file, do the following from BGAN LaunchPad main menu: 

1. Select File > Network Log File. The Network Log dialog box displays, as shown below: 

 

2. Select the file to email from the Select network log file: drop down list. 
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3. Click on E-Mail to open a new message in your Email application, addressed to your support contact and with 
the log file attached. You can type in a message, if required. 

TERMINAL LOGGING 

When displaying the log file contents of the terminal log file, you have the option to view full log file contents or 
only a specific number of lines. To display terminal logging, from the LaunchPad main menu: 

1. Select File > BGAN Log. The BGAN Terminal Log File Management Dialog box displays. 

2. Select the file to email from the Select BGAN log file: drop-down list. 

3. Click on Email to open a new message in your Email application, addressed to your support contact and with 
the log file attached. You can type in a message, if required. 

PRINTING LOG FILES 

You can print an event log file, a network log file or a BGAN log file from BGAN LaunchPad main menu.  

EVENT LOGGING 

To print an event log file from your computer, do the following from BGAN LaunchPad main menu: 

1. Select File > Event Log File. The Event Log dialog box displays, as shown below: 

 

2. Select a log file from the Select event log file drop-down list.  

3. Click on Print to open your operating system's print dialog box, and print the log file. 
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NETWORK LOGGING 

To print a network log file from your computer, do the following from BGAN LaunchPad main menu: 

1. Select File > Network Log File. The Network Log dialog box displays, as shown below: 

 

2. Select a log file from the Select network log file drop-down list.  

3. Click on Print to open your operating system's print dialog box, and print the log file. 
 

TERMINAL LOGGING 

To print a BGAN log file from your computer, do the following from BGAN LaunchPad main menu: 

1. Select File > Terminal Log File. The dialog box displays. 

2. Select a log file from the Select BGAN Log File drop-down list.  

3. Click on Print to open your operating system's print dialog box, and print the log file. 
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SAVING LOG FILES TO DISK 

You can save an event log file, a network log file or a BGAN log file to a file on your computer from BGAN 
LaunchPad main menu.  

EVENT LOGGING 

To save an event log file, do the following from BGAN LaunchPad main menu: 

1. Select File > Event Log File. The Event Log dialog box displays, as shown below: 

 

2. Select a log file from the Select event log file drop-down list.  

3. Click on Save. The directory folder for your operating system opens.  

4. Navigate through to the required directory, and save the log file under the selected name. 

NETWORK LOGGING 

To print a network log file from your computer, do the following from BGAN LaunchPad main menu: 

1. Select File > Network Log File. The Network Log dialog box displays, as shown below: 
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2. Select a log file from the Select network log file drop-down list.  

3. Click on Save. The directory folder for your operating system opens. 

4. Navigate through to the required directory, and save the log file under the selected name. 

TERMINAL LOGGING 

To print a BGAN log file from your computer, do the following from BGAN LaunchPad main menu: 

1. Select File > BGAN Log. The BGAN Terminal Log File Management Dialog box displays. 

2. Select a log file from the Select BGAN log file drop-down list.  

3. Click on Save. The directory folder for your operating system opens. 

4. Navigate through to the required directory, and save the log file under the selected name. 

TURNING LOGGING ON AND OFF 

You can turn event logging or network logging on or off from BGAN LaunchPad main menu.  

EVENT LOGGING 

To turn event logging on or off, do the following from BGAN LaunchPad main menu: 

1. Select File > Event Log FIle. The Event Log dialog box displays. 

2. Check the Turn logging on/off check box to turn logging on, or uncheck the check box to turn logging off. 

3. Click OK to save the change. 
 

NETWORK LOGGING 

To turn network logging on or off, do the following from BGAN LaunchPad main menu: 

1. Select File > Network Log File. The Network Log dialog box displays, as shown below: 

 

2. Check the Turn logging on/off check box to turn logging on, or uncheck the check box to turn logging off. 

3. Click OK to save the change. 
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 POWER-ON SELF-TEST 
 

 SATELLITE TERMINAL BOOT BEHAVIOR 
When the terminal is powered up, it goes through a two-phase boot process. The first phase loads a Minimum 
Boot ROM (MBR) module, which provides basic functionality, including self-test and basic network connectivity. 

When the self-test has completed with no failures detected, the MBR then proceeds to the second phase, and 
loads the application module. This provides full terminal functionality. 

If the applications module is not installed or is bad, a new application has to be installed. A bad application could 
cause the terminal to stall in the second phase, or constantly reset. To prevent this, the boot process can be 
stopped at the MBR phase, so that a new application can be installed. This is achieved by holding down the audio 
button at the same time as the power button is pressed. 

If the audio button is accidentally pressed during power up, causing the boot process to stop at the MBR phase, 
then simply power cycle the terminal. It will power-up through both phases of the boot process. 

If the terminal MBR module detects a failure during the self-test, it will stop the boot process and indicate the 
source of the failure through the 6 LEDs used for pointing, as follow: 

 

Pointing LED Color and Status 

G Solid green LED 

R Solid red LED 

B Blank or off LED 

BG Blinking green LED 

BR Blinking red LED 

 

1 2 3 4 5 6 Description of Failure Action 

R B B B B B The main processor has failed to start Note 1 

G BR BR B B B The main processor has detected a fault in its memory Note 1 

G BR BG BR B B The terminal SW is not properly installed Note 2 

G BR BG BG BR B The terminal SW is not properly installed Note 2 

G G BR BR B B The main processor has detected a fault in the Ethernet 
interface 

Note 1 

G G BR BG BR B The main processor has detected a fault in the USB 
interface 

Note 1 

G G BR BG BG BR The main processor has detected a fault on the WLAN 
interface 

Note 1 

G G G BR B B The main processor has detected a fault in the ASIC   Note 1 

G G G BR BG BR The main processor has detected a fault in the transmitter Note 1 
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1 2 3 4 5 6 Description of Failure Action 

G G G BR BR BG The secondary processor has detected a fault in its 
memory 

Note 1 

G G G BG BR BR The secondary processor has failed to start Note 1 

 

Note 1:  Remove all data cables and power cables from the UT (remember to remove the battery). Wait 30 
seconds, then reconnect power and re-start the terminal. If this does not clear the failure, you will need to return 
the terminal for repair. 

Note2:  Re-load the terminal’s SW using the BGAN LaunchPad. 



 

BGAN Terminal User's Guide 97 

 

 TROUBLE SHOOTING 
 

Problem Possible Cause Possible Solution 

Terminal will not turn on Power button not pressed for long enough  

Discharged battery 

Battery not fitted 

Press the button for 2 seconds 

Connect the AC/DC adaptor 

Connect the AC/DC adaptor 

Battery does not charge Battery is defective (battery LED is flashing red) 

Battery temperature is outside charging range 

Replace battery 

Battery will only be charged at 
temperatures between 0C and 45 
degrees C.  

Cannot insert battery into 
terminal 

Battery incorrectly oriented Ensure the battery is oriented as 
shown in First Time Setup 

Cannot insert USIM card 
holder into terminal 

USIM is not correctly seated in the card holder 

Card holder incorrectly oriented 

Ensure the USIM is pressed firmly into 
the card holder 

Ensure the card holder is oriented as 
shown in First Time Setup 

Cannot lock the terminal’s 
stand at the desired 
protractor angle 

Lock knobs are not tight enough Ensure lock knobs are turned in the 
direction shown on the knobs. Both 
knobs will gradually tighten if you push 
the unit to a lower angle. This can help 
with locking the unit when the desired 
protractor angle is close to 90 degrees.  

Terminal’s lock knobs cannot 
be loosened 

Closing the stand has tightened both lock knobs Open the terminal’s stand, this will 
automatically loosen the lock knobs. 

The Terminal tips forward. The stabilizer has not been deployed See Terminal Stand Positioning 

In a fixed installation, the 
terminal will not turn on and  
reconnect to the BGAN 
system after a power outage 

Terminal’s automatic modes are not set 
correctly 

Set the automatic modes, see 
Fixed/Semi-fixed Installation 

The BGAN LaunchPad will 
not connect to the terminal 

No interface connection between the terminal 
and computer 

 

Ensure there is a WLAN, ethernet or 
USB connection between the terminal 
and computer, see Connecting the 
Terminal to the Computer 

The BGAN LaunchPad will 
not connect to the terminal 
over the WLAN interface 

WLAN WEP is enabled on terminal and the 
computer’s WLAN  is not programmed with 
the WEP keys 

 

 
WLAN signal is not strong enough 

Disable WEP, or use the same WEP 
keys for both the terminal and 
computer. For details, go to 
Connecting Terminal to PC and 
other devices via WLAN interface 

Locate the terminal and computer to 
reduce any obstructions between 
them, and locate them closer together. 
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Problem Possible Cause Possible Solution 

Terminal will not accept 
incoming ISDN calls 

Incorrect MSN programmed into the ISDN 
device 

 

Incorrect MSN programmed into the terminal 

Ensure the appropriate MSN is 
programmed into the ISDN device, see 
Voice Telephony Services and 
ISDN Data 

Ensure the appropriate MSN is 
programmed into the terminal, see 
ISDN Equipment 

Terminal will not make 
outgoing ISDN calls 

The ISDN interface is turned off (Note the 
interface turns off automatically when the 
terminal is operating from battery power, if no 
ISDN device is detected within 5 minutes from 
power on) 

Enable the ISDN interface from the 
BGAN LaunchPad, see ISDN 
Equipment  

Alternatively, turn the terminal off, 
then turn it on and immediately 
connect the ISDN device 

Terminal is connected to the 
BGAN network, but cannot 
obtain the requested Quality 
of Service 

The terminal is not optimally pointed at the 
satellite 

Re-point the terminal, see Pointing 
the Terminal.  

Ensure the following minimum LEDs 
are lit for the requested Quality of 
Service: 

Streaming 256: all LEDs green 

Streaming 128: 3 green + 1 red LED 

Streaming 64: 2 green + 1 red LED 

Streaming 32: 1 green + 1 red LED 

background or standard: 1 red LED 

ISDN data (64kbps): 2 green + 1 red 
LED 

CS voice (4): 1 red LED 

Terminal does not obtain a 
GPS fix 

Terminal’s location limits visibility of 4 or more 
GPS satellites. 

Move the terminal to a location where 
there are few obstructions such as 
trees or tall buildings, so that as much 
as possible of the sky is visible; see 
Obtaining a GPS fix 

You hear a continuous beep 
from the UT when you 
connect an ISDN device to 
the ISDN port 

The ISDN device is trying to draw too much 
power from the satellite terminal’s ISDN 
interface 

 

 

The device yuo are connecting is not an ISDN 
device. It might be an ethernet device that you 
are accidentally connecting to the ISDN port. 

Only connect an ISDN devices that 
draws less than 70mA of current at 
40V (equivalent power 2.8W) 

 

Make sure you connect only ISDN 
devices to the ISDN port 

None of the above solutions 
resolve the problem 

Terminal may have a hardware or software 
fault, and needs to be re-booted. 

Remove both the AC/DC adaptor and 
battery. Wait 30 seconds. Reconnect 
the AC/DC adaptor or the battery, 
and turn on the terminal. 

As the terminal powers up, check the 
status of the LEDs, see Satellite 
Terminal Boot Behavior 
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 TECHNOLOGY OVERVIEWS 
 

GPS 
The Global Positioning System (GPS) uses 24 orbital satellites to fix the position of the Terminal anywhere on the 
globe.  

OBTAINING A GPS FIX 

In normal operation, a GPS receiver, such as that built in to the Terminal, needs to be able to receive signals from 
at least four satellites so that it can then calculate a latitude, a longitude and an altitude – this position fix is 
referred to as a 3-dimensional or 3-D fix. If only three GPS satellites can be seen by the GPS receiver, then the last 
available altitude measurement is assumed and the GPS receiver calculates a position fix based on latitude and 
longitude only. This simpler position fix is referred to as a 2-dimensional or 2-D fix and is quicker and easier to 
obtain than a 3-D fix, but may be less accurate. 

The GPS receiver may take between a few seconds and 20 minutes to obtain a GPS fix, depending on how 
frequently the GPS receiver is being used. The frequency of use determines the how quickly the GPS Terminal is 
able to start. 

 Hot start − if the GPS receiver is being used frequently, (that is, at least every two to six hours), it is 
regularly updated with data from the GPS satellites, and so only takes a short time to obtain a GPS fix after 
being switched on. 

 Warm start − if a GPS receiver has not been used for more than six hours, then it will take longer to obtain 
a GPS fix, perhaps up to 45 seconds.  

 Cold start − if the GPS receiver has not been used for some time or is 300 km or more from where it was 
last used, it can take between 10 and 20 minutes to obtain a valid position fix.  

The time taken to obtain a valid GPS fix can also be affected by the visibility that the GPS receiver has of the GPS 
satellites. The GPS system is relatively tolerant of atmospheric conditions such as heavy cloud or rainfall. However, 
physical blockages, such as tall buildings or terrain can significantly degrade the ability of the GPS receiver to obtain 
a fix. For this reason, ensure that the GPS receiver has as clear as view of as much open sky as possible. 

GPS AND BGAN REGISTRATION 

BGAN uses the accurate positional and timing information obtained from GPS to help ensure efficient registration 
of a BGAN Terminal with the BGAN network.  

Following successful registration and providing the Terminal is left switched on and remains stationary, the GPS is 
no longer needed. Periodically, the BGAN Terminal contacts the BGAN network to inform the network that it is 
still switched on. In addition, the BGAN network periodically checks each Terminal for activity, and if there has 
been no traffic through the Terminal, and the Terminal has not automatically contacted the BGAN network as 
described above, then the Terminal will be de-registered from the network. 
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ISDN 
ISDN (Integrated Services Digital Network) is the ITU-T (formerly CCITT) term for the digital public 
telecommunications network. ISDN is offered in two packages - Basic Rate and Primary Rate. 

BASIC RATE 

Basic Rate (also known as 2B+D), provides two 64Kbps (B) data channels and one 16Kbps (D) signaling channel. It 
is intended for individual users and business applications such as LAN data links, or high quality audio feeds for 
broadcast media applications. It is provided as a dial-up service by the local telephone service provider and is 
charged, like a normal telephone service, on the basis of a standing monthly or quarterly charge, plus a usage 
charge per minute. The terrestrial usage charge per channel is similar to normal telephony rates.  

Because the Inmarsat BGAN service operates at 64Kbps (that is, one B channel), it is normally used with Basic 
Rate ISDN. 

PRIMARY RATE 

Primary Rate provides up to thirty 64Kbps (B) data channels and one 64 Kbps (D) signaling channel. It is aimed at 
high bandwidth business applications such as video-conferencing and high capacity on-demand LAN bridge/router 
links. 

The communications interface to which ISDN equipment is connected is usually referred to as the S/T-interface or 
S/T bus (also S0 interface and S0 bus). Physically the S/T interface is an RJ-45 connector (not to be confused with 
an Ethernet connection, which uses an identical connector). 

DIALING AND NUMBERING 

DIALING 

As the ISDN numbering system follows the same pattern as the normal telephone system, dialing is carried out in 
exactly the same manner as making a normal telephone call. The subscriber number is used with the same 
international and area codes as the telephone network. 

MULTI-SUBSCRIBER NUMBERING (MSN) 

ISDN supports Multi-Subscriber Numbering (MSN). MSN is a facility whereby more than one telephone number 
can be allocated to an ISDN line. Each incoming number on the same ISDN line can be routed to a different piece 
of equipment depending on the phone number called. For instance one number might route straight through to a 
fax machine on an analogue port, whilst another number might go to a telephone, and a third number might go to 
the serial port on a terminal adaptor. 

MSN allows you have up to 10 directory numbers associated with an ISDN line. Each device connected to the 
ISDN line will need to be configured with its own MSN number so that it can recognize and respond to incoming 
calls. Typically, the numbers will be the same apart from the last digit which will be in the range 0-9, thus giving 10 
individually assigned numbers. 



 

BGAN Terminal User's Guide 101 

 

PDP CONTEXT 
A Packet Data Protocol (PDP) Context defines connection aspects such as routing, Quality of Service (QoS), 
security and billing between a mobile user terminal, such as the BGAN Terminal, and a data network. PDP 
Contexts are essential to the General Packet Radio Service (GPRS) system, which is used by GSM and UMTS-
based 3G networks worldwide for transmitting data.  

In order for a user to be able to transfer data across a network, a PDP Context must be activated in the Terminal 
and associated GPRS Core Network. The procedure for this is as follows: 

1. After registration with the network, the user activates a PDP Context using an application on the computer or 
Terminal, and requests sufficient radio resources (that is, power and bandwidth) to support the context 
activation procedure. 

2. Once the resources are allocated, the Terminal sends the Activate PDP Context request to the GPRS Core 
Network. This request includes key information about the mobile user's PDP address (for example an IP 
address), PDP type (that is, static or dynamic address) the QoS requested for this context, the APN of the 
external network to which connectivity is requested, the user's identity (IMSI) and any necessary IP 
configuration parameters (for example, security settings). 

3. On receiving the Activate PDP Context message, the GPRS Core Network checks the user's subscription 
record to establish whether the request is valid. If the request is valid, a virtual connection is established 
between the Terminal and the GPRS Core Network, and data transfer can then take place between the 
Terminal and the external data network, within the scope of the current PDP Context. The PDP Context is 
stored in both the Terminal and the GPRS Core Network. 

A single Terminal may have multiple PDP Contexts each with different QoS profiles. The primary PDP Context is 
a PDP Context with default QoS profile attributes and is always activated first. All other PDP Contexts with the 
same PDP Address are secondary PDP Contexts. Secondary PDP Contexts share the same PDP Address and 
connect to the same APN but may have different QoS profiles. 

 

WLAN 
Wireless Local Area Networking (WLAN) enables two or more computers equipped with wireless adapter cards 
to share resources. 

A wireless network at its most basic comprises of two or more computers each equipped with wireless adapter 
cards forming a network. When the computers are within range of each other each computer has access only to 
the resources of the other computer but not to any central server or other resource. This type of basic 
configuration is known as an ad hoc network. 

A more common and efficient use of a wireless network is one in which two or more computers equipped with 
wireless adapter cards are linked to a WLAN Access Point. The Access Point allows each computer to have access 
to shared resources, such as a broadband Internet connection, as well as to other computers on the network. 
Such a configuration is know as Infrastructure Mode. 

PERFORMANCE 

The performance of a WLAN network will be influenced by several factors including the number of users on the 
network, the location of the antenna, the distance from the antenna and the degree of blocking from buildings and 
other infrastructure. Typical operating ranges are 200-300 meters outdoors and 30-60 meters indoors, the 
performance degrading gradually as the signal strength decreases. 

SSID 

A wireless network is identified by a Service Set Identifier or SSID. An SSID is also referred to as a Network Name 
because it is a name that identifies a wireless network. Wireless devices that wish to communicate with each other 
must be configured with the same SSID. Several Access Points can be set up using the same SSID so that users can 
roam from one Access Point to the other without losing network access. The SSID is broadcast so that any 
wireless device in range can read the SSID and ask permission to associate with it. The SSID is not intended as a 
security measure − it is used only to identify different networks. 
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 TECHNICAL SPECIFICATIONS 
 

Weight 2.8 kg (terminal with battery) 

Dimensions 27.5 cm  x 34.5 cm x 5.0 cm 

Battery Life 

(actual performance 
based on range of 
factors and actual usage) 

Transmit:  162 Mb 

Receive:  864 Mb 

36 hours standby time 

(standard battery) 

Humidity 95% RH at +40˚C 

Temperature -25˚C to +60˚C operating 

-25˚C to +80˚C storage 

Water & Dust IP-55 standard 

Transmitter power 20dBW EIRP maximum 

Antenna 
characteristics 

Nominal gain 15dBi, nominal 3dB beamwidth ±20 degrees. 

The Satellite Terminal carries a warranty for 12 months from the date of sale. Contact you Service Provider if you 
have questions about the warranty, or need to return the terminal for repair. 
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 DECLARATION OF CONFORMITY 
Hughes Network Systems, LLC, of 9605 Scranton Road, San Diego, CA, 92121, USA, declares under our sole 
responsibility that the product HNS-9201 Satellite IP Terminal to which this declaration relates, is in conformity 
with the following standards and/or other normative documents: 

ETSI EN 301 444 , ETSI EN 300 328, ETSI EN 301 489-1, ETSI EN 301 489-17, ETSI EN 301 489-20, IEC 60950-1, 
Council Recommendation 1999/519/EC. 

We hereby declare that all essential radio test suites have been carried out and that the above named product is in 
conformity to all the essential requirements of Directive 1999/5/EC. 

The conformity assessment procedure referred to in Article 10 and detailed in Annex [III] or [IV] of Directive 
1999/5/EC has been followed with the involvement of the following Notified Body(ies):  

BABT, Balfour House, Churchfield Road, Walton-on-Thames, KT12 2TD, UK. 

Identification mark: 0168 (Notified Body number). 

The technical documentation relevant to the above equipment will be held at: 

 Hughes Network Systems, LLC, 9605 Scranton Road, San Diego, CA, 92121, USA 

 Signed by Peter Sroka (Senior Technical Director, August 12, 2005) and Bill Lindsay (Senior Program Manager, 
August 12, 2005). 

EU WEEE (WASTE ELECTRICAL AND ELECTRONIC EQUIPMENT) 
DIRECTIVES  

 

The European Union (EU) directive on waste electrical and electronic equipment mandates recycling of electrical 
and electronic equipment throughout the EU by August 13, 2005. 

Unless otherwise noted, all products, assemblies, and sub-assemblies manufactured by HNS and its sub-contractors 
will be compliant with this directive and any subsequent revisions or amendments. This product carries the WEEE 
label below to demonstrate compliance. 

For addition information, contact Hughes Network Systems at: www.hns.com. 
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 GLOSSARY 
 

APN: An Access Point Name (APN) provides access to an external network. By default, the SIM Card in your 
terminal is configured with the APN of your Service Provider. You may want to configure further APNs if you 
have arranged with your Service Provider to use more than one SIM Card.  

BGAN Satellite Terminal: Referenced throughout this document as the Satellite Terminal or “The Terminal,” 
this device implements and manages BGAN satellite communications between your computer and Service 
Provider’s network.  

Quality of Service: Quality of Service (QoS) assigns a level of priority to certain types of data traffic, in particular 
high bandwidth applications such as video and multimedia. QoS attempts to maintain a guaranteed throughput 
level, and minimize error rates and end to end latency, so providing a higher level of service than "best effort" 
protocols.  

DNS Server: The Domain Name System (DNS) is an Internet service that is required because the Internet does 
not recognize the text-based Web address or email address that you type into your Web browser or email 
application. All or part of a Web address or an email address is a domain name, and DNS translates this 
domain name into an IP address that is recognized by the Internet. 

A DNS Server holds a database of domain names and IP addresses, so that when you enter a Web address or 
email address, you are sent to the correct IP address over the Internet. 

Dynamic DNS Server: If you are using dynamic IP addressing, Inmarsat recommends that you use a dynamic 
DNS server. A dynamic DNS server updates the IP address information in the DNS database each time 
your IP address changes. A dynamic DNS server also enables a computer using a dynamic IP address to 
use network applications that normally require a static IP address, for example FTP servers. This service 
requires subscription with a Dynamic DNS provider. 

Static DNS Server: If you are using static IP addressing, Inmarsat recommends that you use a static DNS 
server. If you select this option, you must enter the IP address of the Primary DNS Server. This is 
supplied by your Internet Service Provider. Optionally, you can enter the IP address of a Secondary DNS 
Server, also supplied by your ISP. This is used in the event of failure of the Primary DNS Server. 

Error correction: Error correction ensures that very little data is lost during transfer by asking for dropped 
packets to be resent. However, because it holds subsequent data whilst the packet is being resent, you may 
notice some jitter or delay in the received data. This is normal for most data types.  

 For real-time applications, such as Voice over IP (VoIP) or video, you may find that the level of jitter or delay 
is too great. In this case, it is recommended that you remove error correction. Removing error correction 
minimizes delay and jitter, but note that a small amount of data may be lost during transfer, because dropped 
data packets are not resent. 

Ethernet: Ethernet is a local area networking method used widely throughout the computer industry. It is one of 
the three communications interfaces supported by the Satellite Terminal. 

Fault Code: A number which uniquely references an error in a hardware or software system. In the Satellite 
Terminal, if there is a fault detected, the fault code and a description are displayed at the bottom of the Mobile 
Terminal Control Pad Home and Status screens. 

GPS: Global Positioning System. When the GPS receiver in the Satellite Terminal gets a bearing on a GPS satellite, 
the receiver computes and stores the Terminal’s location on earth. That location is used in the Pointing 
Process to obtain your location relative to the Regional BGAN Satellite. 

Header Compression: A header is the component of a data packet that precedes the data that you are sending. 
The header contains information such as source and destination address, error checking and other 
administrative details. In most data types this does not noticeably affect the data transmission rates. However 
in multimedia applications such as voice and video, the header can significantly affect performance. 

Inmarsat recommends that you switch on header compression for multimedia applications, such as video. 

IP Address: An Internet Protocol address, or IP address, is a number that identifies the computer that is sending 
or receiving information transmitted over the Internet. An IP address is made up of four groups of numbers 
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between 0 and 255, separated by periods. For example, 207.115.79.4 is an IP address. In the BGAN system, IP 
addresses can be dynamic or static. 

Dynamic IP Address: A dynamic IP address is a temporary address that is assigned by your Internet Service 
Provider (ISP) when you connect to the Internet. If you do not need a permanent IP address, Inmarsat 
recommends that you obtain a dynamic IP address. Normally, individual users of the Internet use a 
dynamic IP address. 

Static IP Address: A static IP address is assigned permanently, and is used every time you connect to the 
Internet. Normally, companies and other organizations that have their own networks use static IP 
addresses. 

SIM Card: Your Service Provider supplies you with a Subscriber Identification Module (SIM) Card or a Universal 
Mobile Telecommunications System Subscriber SIM (USIM) Card.  

A SIM or USIM Card is a card commonly used in a GSM phone. The card holds a microchip that stores 
information and encrypts voice and data transmissions, making it extremely difficult to listen in on calls. The 
USIM Card also stores data that identifies the caller to the Service Provider. 

Standard: A standard connection is charged per Mb. You are charged only for the transmitted data. The 
bandwidth you are allocated depends on terminal type and network availability, but is always ‘best effort’, that 
is, you are allocated bandwidth depending on your requirements and the requirements of other users of the 
BGAN network, or BGAN Terminal. This connection class is suitable for most data types, other than 
multimedia. 

Streaming: A streaming connection is charged by time. You are charged for the amount of time the connection is 
active. Streaming enables multimedia data, such as video, to be sent in a continuous data stream and converted 
into sound and pictures. The bandwidth required for a streaming connection is difficult to predict, and 
depends on factors such as length of connection and number of receivers.  

Symmetrical Rate: The rate at which streaming data is transmitted, in kilobytes (KB). This rate applies to 
transmitted (uplink) and received (downlink) data. 

Desired Symmetrical Rate: From the drop-down list, choose the desired data rate for your Streaming 
connection. This can be 32 Kb, 64 Kb, 128 Kb or 256 Kb. This figure is guaranteed, unless the connection 
cannot meet this requirement because of bandwidth restrictions. In this case the rate defaults to the 
minimum symmetrical rate. 

Minimum Symmetrical Rate: From the drop-down list, choose the minimum data rate that you are 
prepared to accept for your Streaming connection. This can be 32 Kbps, 64 Kbps, 128 Kbps or 256 Kbps. 
This rate must be lower than the Desired Symmetrical Rate. If the connection cannot meet this 
requirement, an error message displays. 

Traffic Flow Template: A Traffic Flow Template, also called an Application Template, is a series of data filters 
such as QoS (Quality of Service), PDP Context and security settings, that allow the GPRS Core Network to 
classify packets received from an external network into the correct PDP Context.  When incoming data 
arrives at an access point in the core network, a packet classifier will make a PDP Context selection based on 
the Traffic Flow Template, and map the incoming data packets into the PDP Context with the correct QoS 
attributes. The use of a Traffic Flow Template allows multiple PDP Contexts to be associated with the same 
PDP address. 

USIM Card: Your Service Provider supplies you with a Subscriber Identification Module (SIM) Card or a 
Universal Mobile Telecommunications System Subscriber SIM (USIM) Card.  

A SIM or USIM Card is a card commonly used in a GSM phone. The card holds a microchip that stores 
information and encrypts voice and data transmissions, making it extremely difficult to listen in on calls. The 
USIM Card also stores data that identifies the caller to the Service Provider. 

Virtual Private Network: A Virtual Private Network (VPN) enables remote offices or users to gain secure 
access their organization's network over the public telecommunications network. This provides the benefits of 
remote access without the expense of dedicated leased or owned lines. VPNs work by using tunneling 
protocols, such as L2TP, to encrypt data at the sending end, and decrypt the data at the receiving end. This 
"tunnel" cannot be accessed by data that is not properly encrypted.  
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